Notice

The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.

©July 2008

Trademarks

This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
   And
2. This device must accept any interference, including interference that may cause undesired operation of the device.
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator and your body.

**Warning**

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.

If your purchase option includes both Wireless LAN and 3.5G modules, then the appropriate antennas will be installed. Note that in order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in conjunction with any other antenna or transmitter.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter – AC Input 100 - 240V, 50 - 60Hz, DC Output 19V, 3.42A OR 18.5V, 3.5A).

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   - Do not expose the computer to any shock or vibration.
   - Do not place it on an unstable surface.
   - Do not place anything heavy on the computer.

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   - Do not expose it to excessive heat or direct sunlight.
   - Do not leave it in a place where foreign matter or moisture may affect the system.
   - Don’t use or store the computer in a humid environment.
   - Do not place the computer on any surface that will block the Vents/Fan Intakes.
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. **Take care when using peripheral devices.**
Power Safety

The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

<table>
<thead>
<tr>
<th>Do not plug in the power cord if you are wet.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Do not plug in the power cord if you are wet." /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Do not use the power cord if it is broken.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image2" alt="Do not use the power cord if it is broken." /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Do not place heavy objects on the power cord.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Do not place heavy objects on the power cord." /></td>
</tr>
</tbody>
</table>

Power Safety Warning

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.
Battery Precautions

- Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
- Do not remove any batteries from the computer while it is powered on.
- Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
- Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
- Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
- Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
- Keep the battery away from metal appliances.
- Affix tape to the battery contacts before disposing of the battery.
- Do not touch the battery contacts with your hands or metal objects.
Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

- When the power cord or AC/DC adapter is damaged or frayed.
- If the computer has been exposed to rain or other liquids.
- If the computer does not work normally when you follow the operating instructions.
- If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
- If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Preface

Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your documents are prepared.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the notebook** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note**: Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and shoulders.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for an extended period of time) take the following precautions:

- Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
- Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
- Rotate desktop background images every few days.
- Turn the monitor off when the system is not in use.
Preface
Contents

Notice .................................................................................I
FCC Statement .............................................................II
FCC RF Radiation Exposure Statement: ................... III
Instructions for Care and Operation ....................... V
Power Safety .............................................................VII
Battery Precautions ................................................. VIII
Cleaning .....................................................................IX
Servicing .................................................................... IX
Travel Considerations ................................................. X

Quick Start Guide
Overview ...............................................................1-1
Model Differences .......................................................1-2
Aluminum Covers .......................................................1-2
LED Backlight LCD (Optional for Model B Computers) ...................................................1-2
Advanced Users ............................................................1-3
Beginners and Not-So-Advanced Users ......................1-3
Warning Boxes .............................................................1-3
Not Included .................................................................1-4
System Software ..........................................................1-5
System Startup ...............................................................1-6
Operating System Setup ...............................................1-7
Inserting the AC/DC Adapter Cable ..............................1-8
System Map: LCD Panel Open - Model A ....................1-9
System Map: LCD Panel Open - Model B ..................1-10
LED Indicators ............................................................1-11
Hot Key Buttons ............................................................1-12
Keyboard ..................................................................1-13
Function/Hot Key Indicators .........................................1-14
System Map: Front & Rear Views ...............................1-15
System Map: Left & Right Views .................................1-16
System Map: Bottom View ..........................................1-18
Windows Vista Start Menu & Control Panel ...............1-19
Video Features .............................................................1-20
Display Devices & Options ..........................................1-20
Power Options ..............................................................1-22

Features & Components
Overview ...............................................................2-1
Hard Disk Drive ..........................................................2-2
Optical (CD/DVD) Device ............................................2-3
Loading Discs ...............................................................2-3
Handling CDs or DVDs ................................................2-4
DVD Regional Codes ....................................................2-5
7-in-1 Card Reader ........................................................2-6
Preface

ExpressCard Slot ........................................................... 2-7
Inserting and Removing ExpressCards .............................. 2-7
TouchPad and Buttons/Mouse ....................................... 2-8
Audio Features ............................................................... 2-9
Adding a Printer ........................................................... 2-10
  USB Printer .............................................................. 2-10
  Parallel Printer .......................................................... 2-10

Power Management

Overview ................................................................. 3-1
The Power Sources ................................................... 3-2
  AC/DC Adapter ........................................................ 3-2
  Battery ................................................................. 3-2
Turning on the Computer ............................................... 3-3
Power Plans ............................................................... 3-4
Power-Saving States .................................................... 3-6
  Sleep ....................................................................... 3-6
  Hibernate .............................................................. 3-7
  Shut Down .............................................................. 3-7
Configuring the Power Buttons ..................................... 3-8
  Resuming Operation ................................................. 3-9
Battery Information ..................................................... 3-10
  Battery Power ......................................................... 3-10
  Conserving Battery Power ......................................... 3-11
  Battery Life ............................................................ 3-12

New Battery ............................................................... 3-12
Recharging the Battery with the AC/DC Adapter ............ 3-12
Proper handling of the Battery Pack ......................... 3-13
Battery FAQ ............................................................... 3-14

Drivers & Utilities

What to Install ........................................................ 4-1
Module Driver Installation ......................................... 4-1
Driver Installation .................................................... 4-2
  Updating/Reinstalling Individual Drivers .................... 4-4
User Account Control (Win Vista) .............................. 4-4
  Windows Security Message ...................................... 4-4
  New Hardware Found ............................................. 4-4
Driver Installation Procedure ....................................... 4-5
  Chipset .................................................................. 4-5
  Video ..................................................................... 4-5
  Audio ..................................................................... 4-5
  Modem .................................................................. 4-5
  LAN ....................................................................... 4-5
  TouchPad .............................................................. 4-6
  CardReader ........................................................... 4-6
  Hot Key ................................................................. 4-6
  Optional Drivers ...................................................... 4-7
  Bluetooth Module ................................................... 4-7
  Wireless LAN Module .............................................. 4-7
PC Camera Module ....................................................4-7
3.5G Module ...............................................................4-7
Fingerprint Reader Module ........................................4-7
Intel Turbo Memory Technology Driver .................4-7

BIOS Utilities
Overview .................................................................5-1
The Power-On Self Test (POST) .................................5-2
Failing the POST ........................................................5-3
Fatal Errors .................................................................5-3
Non-Fatal Errors ..........................................................5-3
The Setup Utility ........................................................5-4
Entering Setup ..............................................................5-4
Setup Screens ...............................................................5-5
Main Menu ..................................................................5-6
System Time & Date (Main Menu) ..............................5-6
SATA Port 1 (Main Menu) ..........................................5-7
SATA Port 2 (Main Menu) ..........................................5-7
System/Extended Memory (Main Menu) ..................5-7
Advanced Menu ........................................................5-8
Advanced Chipset Control (Advanced Menu) ..........5-8
Installed O/S (Advanced Menu) .................................5-9
SATA Mode Selection (Advanced Menu) .................5-9
DFOROM (Robson) Support (Advanced Menu > SATA
Mode Selection [AHCI] ..............................................5-9
Reset Configuration Data (Advanced Menu) ..........5-10
Boot-time Diagnostic Screen (Advanced Menu) .......5-10
Legacy OS Boot (Advanced Menu) .........................5-10
Power On Boot Beep (Advanced Menu) ....................5-10
Battery Low Alarm Beep (Advanced Menu) .............5-10
Fan Control (Advanced Menu) .................................5-10
Security Menu ..........................................................5-11
Set Supervisor Password (Security Menu) ...............5-11
Set User Password (Security Menu) .........................5-12
Fixed disk boot sector (Security Menu) ....................5-12
Password on boot (Security Menu) .........................5-12
Boot Menu .................................................................5-13
Exit Menu .................................................................5-14

Upgrading The Computer
Overview .................................................................6-1
When Not to Upgrade .................................................6-2
Removing the Battery ..................................................6-3
Upgrading the Hard Disk Drive .................................6-4
Upgrading the Optical (CD/DVD) Device .................6-6
Upgrading the System Memory (RAM) ....................6-7
Upgrading the Processor .............................................6-10

Modules & Options
Overview ..................................................................7-1
Preface
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2  A guide to using some of the main features of the computer e.g. the storage devices (hard disk, optical device, 7-in-1 card reader, ExpressCard/34/54), TouchPad & Mouse, Audio & Printer.
• Chapter 3  The computer’s power saving options.
• Chapter 4  The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
• Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6  Instructions for upgrading your computer.
• Chapter 7  A quick guide to the computer’s Bluetooth, Wireless LAN, PC Camera, 3.5G, Fingerprint and Turbo Memory modules (some of which may be optional depending on your purchase configuration).
• Chapter 8  A troubleshooting guide.
• Appendix A  Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.
• Appendix B  Information on the Intel Video driver controls.
• Appendix C  The computer’s specification.
• Appendix D  Information on the Windows XP OS.
Model Differences
This notebook series includes two different model types (there are also some designs styles that include aluminum top covers) which differ slightly in design style and LCD size (see “Specifications” on page C - 1). Note that your model’s color may appear different from those pictured throughout this manual (the power and hot key buttons will help you differentiate clearly between the two model types).

Aluminum Covers
Note that this computer series includes some model designs with aluminum top covers. In order to clean this type of cover use a soft, clean, slightly damp cloth to carefully wipe of any marks (e.g. fingerprints). DO NOT use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

LED Backlight LCD (Optional for Model B Computers)
An LED Backlight LED is available as an option for Model B computers. These type of LCDs allow for greater color quality and consume less power than conventional fluorescent LCDs, and therefore can save significant battery life.
Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in the Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the symbol. Also please note the safety and handling instructions as indicated in the Preface.
Quick Start Guide

Not Included
Operating Systems (e.g. Windows Vista/Windows XP) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you); refer to Chapter 4 for installation instructions.

Ports and Jacks
See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
# System Software

Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find the following operating systems are supported.

<table>
<thead>
<tr>
<th>Operating System &amp; Version</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Windows XP (Home or Professional)</td>
<td>In order to run Windows XP without limitations or decreased performance, your computer requires a minimum <strong>512MB</strong> of system memory (RAM)</td>
</tr>
<tr>
<td>Windows Vista - SP1 (64-bit) Home Basic Edition</td>
<td>In order to run Windows Vista without limitations or decreased performance, your computer requires a minimum <strong>1GB</strong> of system memory (RAM).</td>
</tr>
<tr>
<td>Windows Vista - SP1 (64-bit) Home Premium Edition</td>
<td></td>
</tr>
<tr>
<td>Windows Vista - SP1 (64-bit) Business/Enterprise/Ultimate Edition</td>
<td></td>
</tr>
</tbody>
</table>

*Table 1 - 1 - Operating Systems Supported*

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Windows XP Information” on page D - 1.*

---

**Windows Vista Service Pack 1**

Make sure you install Windows Vista Service Pack 1 (or a Windows Vista version which includes Service Pack 1) before installing any drivers. Go to the Microsoft website for download details, or contact your service center.
Quick Start Guide

System Startup

1. Remove all packing materials, and place the computer on a stable surface.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Attach the AC/DC adapter to the DC-In jack on the left of the computer (see over), then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
4. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees) while using the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by the lid/LCD).
5. Press the power button to turn the computer "on".

Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button Menu in Windows Vista. This will help prevent hard disk or system problems.

Figure 1 - 1 - Opening the Lid/LCD/Computer with AC/DC Adapter Plugged-In
Operating System Setup

If you are installing new system software, or are re-configuring your computer for a different system, make sure you configure the appropriate OS setting in the BIOS before installing a new operating system (see “Advanced Menu” on page 5 - 8 for further information).

1. Start-up the computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select "Installed O/S" and make sure the appropriate operating system is selected.
3. Go to the Exit menu and select "Exit Saving Changes" (or press F10 and select "Yes" then press Enter) and press Enter to exit the BIOS and reboot the computer.

**Figure 1 - 2 - Advanced BIOS Menu**

SATA Mode Selection & Intel Turbo Memory

If you select the Vista O/S then the SATA Mode Selection menu will become available.

If you have included an Intel Turbo Memory module in your purchase configuration you will need to enable DFOROM (Robson) Support and then install the driver (see “Intel Turbo Memory Module” on page 7 - 34).
Quick Start Guide

Inserting the AC/DC Adapter Cable

Take care when connecting the AC/DC adapter cable into the DC-In jack on the computer. The combination of some case designs and AC/DC adapters will expose part of the end of the adapter cable when connected to the DC-In jack (see Figure 1 - 3); this is a normal situation.

DO NOT insert the adapter cable into the DC-In jack any further than necessary (i.e. until you meet resistance), otherwise you may cause damage to the computer. The LED indicator  will be orange when the adapter is connected.

Figure 1 - 3 - Computer with AC/DC Adapter Plugged-In
System Map: LCD Panel Open - Model A

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the key combinations to toggle power to the 3.5G/WLAN/Bluetooth modules, and check the LED indicator icon to see if the modules are powered on or not (see Table 1 - 5, on page 1 - 14 Table 1 - 2, on page 1 - 11).

Figure 1 - 4
LCD Panel Open - Model A

1. Built-In PC Camera (Optional)
2. LCD
3. Speakers
4. Power Button
5. Hot Key Buttons
6. LED Status Indicators
7. Keyboard
8. Touchpad & Buttons
9. LED Power & Communication Indicators
10. Fingerprint Module (Optional)
11. Built-In Microphone

Note the cleaning instructions for aluminum covers - see page 1 - 2.
System Map: LCD Panel Open - Model B

1. Built-In PC Camera (Optional)
2. LCD (LED Backlight LCD Optional)
3. Built-In Microphone
4. Power Button
5. Hot Key Buttons
6. LED Status Indicators
7. Keyboard
8. Touchpad & Buttons
9. LED Power & Communication Indicators
10. Fingerprint Module (Optional)

Note the cleaning instructions for aluminum covers - see page 1 - 2.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the key combinations to toggle power to the 3.5G/WLAN/Bluetooth modules, and check the LED indicator icon to see if the modules are powered on or not (see Table 1 - 5, on page 1 - 14/Table 1 - 2, on page 1 - 11).
LED Indicators
The two sets of LED indicators (LED Status Indicators and LED Power & Communication Indicators) on the computer display helpful information about the current status of the computer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟</td>
<td>Green</td>
<td>Silent Mode Activated (see over)</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Normal Mode Activated (see over)</td>
</tr>
<tr>
<td>⚡</td>
<td>Green</td>
<td>Hard Disk Activity</td>
</tr>
<tr>
<td>🎆</td>
<td>Green</td>
<td>Number Lock Activated</td>
</tr>
<tr>
<td>🛠️</td>
<td>Green</td>
<td>Caps Lock Activated</td>
</tr>
<tr>
<td>🔐</td>
<td>Green</td>
<td>Scroll Lock Activated (to activate press Fn &amp; Scr Lk)</td>
</tr>
</tbody>
</table>

*Table 1 - 2 - LED Status Indicators*

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚡</td>
<td>Orange</td>
<td>DC Power is Plugged In</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Computer is On</td>
</tr>
<tr>
<td></td>
<td>Blinking Green</td>
<td>The Computer is in Sleep Mode</td>
</tr>
<tr>
<td>⚡</td>
<td>Orange</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Battery is Fully Charged</td>
</tr>
<tr>
<td></td>
<td>Blinking Orange</td>
<td>The Battery Has Reached Critically Low Power Status</td>
</tr>
<tr>
<td>⚫</td>
<td>Green</td>
<td>The (optional) Wireless LAN Module is Powered On</td>
</tr>
<tr>
<td></td>
<td>Orange</td>
<td>The (optional) Bluetooth Module is Powered On</td>
</tr>
<tr>
<td>⚫</td>
<td>Green</td>
<td>The (optional) 3.5G Module is Powered On</td>
</tr>
</tbody>
</table>

*Table 1 - 3 - LED Power & Communication Indicators*
Quick Start Guide

Hot Key Buttons

These buttons give instant access to the default Internet browser and e-mail program, and allow you to toggle the Silent Mode on/off with one quick button press.

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>💌</td>
<td>Activate the Default E-Mail Browser</td>
</tr>
<tr>
<td>🕵️‍♂️</td>
<td>Activate the Default Internet Program</td>
</tr>
<tr>
<td>🌟</td>
<td>Toggle *Silent Mode (for power saving)</td>
</tr>
</tbody>
</table>

*Table 1 - 4 - Hot Key Buttons*

*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce computer performance.*
Keyboard

The keyboard has a numerical keypad for easy numeric data input, and features function keys to allow you to change operational features instantly. See Table 1 - 5, on page 1 - 14 for full function key combination details.

Figure 1 - 6 - Keyboard

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot-keys unique to the system’s regular keyboard may not work.

NumLk & ScrLk

Hold down the Fn Key and either NumLk or ScrLk to enable number or scroll lock, and check the LED indicator for status.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that NumLk is on.
**Quick Start Guide**

**Function/Hot Key Indicators**

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the **Fn** key is held down. In addition to the basic function key combinations; visual indicators are available when the hot key utility is installed (see “Hot Key” on page 4 - 6). When the driver is installed, an icon will appear in the taskbar.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F$n + ~</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>F$n + F7</td>
<td>Display Toggle</td>
</tr>
<tr>
<td>F$n + 3.5G</td>
<td>3.5G Module Power Toggle</td>
<td>F$n + F8/F9</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>F$n + F1</td>
<td>TouchPad Toggle</td>
<td>F$n + F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>F$n + F2</td>
<td>Turn LCD Backlight Off</td>
<td>F$n + F11</td>
<td>WLAN Module Power Toggle</td>
</tr>
<tr>
<td>F$n + F3</td>
<td>Mute Toggle</td>
<td>F$n + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
<tr>
<td>F$n + F4</td>
<td>Sleep Toggle</td>
<td></td>
<td>*Silent Mode Toggle</td>
</tr>
<tr>
<td>F$n + F5/F6</td>
<td>Volume Decrease/Increase</td>
<td></td>
<td>*Silent Mode Toggle</td>
</tr>
</tbody>
</table>

*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce computer performance.

**Table 1 - 5 - Function & Hot Key Indicators**

1 - 14 Function/Hot Key Indicators
1. LED Power & Communication Indicators
2. 7-in-1 Card Reader
3. S/PDIF-Out Jack
4. Microphone-In Jack
5. Headphone-Out Jack
6. Battery

7-in-1 Card Reader
The card reader allows you to use the most popular digital storage card formats:
- MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) / Mini SD (requires PC adapter) / RS MMC (requires PC adapter)
Quick Start Guide

System Map: Left & Right Views

Figure 1 - 8
Left & Right Views

1. DC-In Jack
2. RJ-45 LAN Jack
3. External Monitor Port
4. Vent/Fan Intake/Outlet
5. 3 * USB 2.0 Ports
6. ExpressCard Slot (see page 2 - 7)
7. Optical Device Drive Bay (for CD/DVD Device - see page 2 - 3)
8. RJ-11 Phone Jack
9. Security Lock Slot

Overheating
To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.
Disk Eject Warning

Don’t try to eject a CD/DVD while the system is accessing it. This may cause the system to “crash”. Stop the disk first then eject it, or press the stop button twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened pencil or any object that may break and become lodged in the hole. Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the system to “crash”.

Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager (Hardware and Sound), then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialog box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code (see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
Quick Start Guide

System Map: Bottom View

Figure 1 - 9
Bottom View

1. Battery (Model B 8 Cell Battery Pictured)
2. Hard Disk Bay Cover (3.5G Module Location)
3. RAM & CPU Bay Cover
4. Vent/Fan Intake/Outlet (Model B Only)
5. Speakers (Model B Only)

CPU
The CPU is not a user-serviceable part. Accessing the CPU in any way may violate your warranty.

Overheating
To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake while the computer is in use.

Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 10 for full instructions.

Model A

Model B
Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu icon, and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers listed in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle to Classic View on.
Quick Start Guide

Video Features

You can switch display devices, and configure display options, from the Display Settings control panel (in Personalization) in Windows Vista as long as the appropriate Intel video driver is installed. For more detailed video information see “Intel Video Driver Controls” on page B - 1.

To access Display Settings in Windows Vista:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution: (Figure 1 - 11 on page 1 - 21).
4. Click the arrow, and scroll to the preferred setting in Colors: (Figure 1 - 11 on page 1 - 21).
5. Click Advanced Settings (button) and click Intel(R) GMA Driver for mobile (tab).
6. Click Graphics Properties (button) (Figure 1 - 11 on page 1 - 21) to access the Intel GMA control panel (this control panel can also be accessed by double-clicking Intel(R) GMA Driver for mobile in Classic View).
7. The Intel GMA control panel can also be accessed by clicking the icon in the taskbar and selecting Graphics Properties from the menu.

Display Devices & Options

Besides the built-in LCD, you can also use an external VGA monitor (CRT) or external Flat Panel Display connected to the external monitor port as your display device.
Figure 1 - 11 - Display Properties Desktop

<table>
<thead>
<tr>
<th>Intel Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Mode</td>
<td>One of the connected displays is used as the display device</td>
</tr>
<tr>
<td>Intel(R) Dual Display Clone Mode</td>
<td>Both connected displays output the same view and may be configured independently</td>
</tr>
<tr>
<td>Extended Desktop Mode</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

Table 1 - 6 - Display Options
Power Options

The **Power Options** (Hardware and Sound menu) control panel icon in *Windows* (see page 1 - 19) allows you to configure power management features for your computer. You can conserve power by means of **power plans** and configure the options for the **power button**, **sleep button**, **computer lid (when closed)**, **display** and **sleep mode** from the left menu. Note that the **Power saver** plan may have an affect on computer performance.

Click to select one of the existing plans, or click **Create a power plan** in the left menu and select the options to create a new plan. Click **Change Plan Settings** and click **Change advanced power settings** to access further configuration options.

Pay attention to the instructions on battery care in “**Battery Information**” on page 3 - 10.

---

*Figure 1 - 12 - Power Options*

**Note:** **Sleep** is the default power saving state in *Windows Vista*
Chapter 2: Features & Components

Overview

Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive
- Optical (CD/DVD) Device
- 7-in-1 Card Reader
- ExpressCard Slot
- TouchPad and Buttons/Mouse
- Audio Features
- Adding a Printer
Features & Components

Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk can be taken out to accommodate other 2.5” serial (SATA) hard disk drives (see “Storage” on page C - 2) with a height of 9.5 mm.

The hard disk is accessible from the bottom of your computer as seen below. For further details see “Upgrading the Hard Disk Drive” on page 6 - 4.

Figure 2 - 1
Hard Disk Location
Optical (CD/DVD) Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the module you purchased (see “Storage” on page C - 2). The optical device is usually labeled “Drive D:” and may be used as a boot device if properly set in the BIOS (see “Boot Menu” on page 5 - 13).

Loading Discs

To insert a CD/DVD, press the open button 1 and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator 2 will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole 3 to open the tray.

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the taskbar to check the setting (see “Audio Features” on page 2 - 9).
Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

- Hold the CD or DVD by the edges; do not touch the surface of the disc.
- Use a clean, soft, dry cloth to remove dust or fingerprints.
- Do not write on the surface with a pen.
- Do not store or place the CD or DVD in high-temperature areas.
- Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
- Do not bend the CD or DVD.
- Do not drop or subject the CD or DVD to shock.
### DVD Regional Codes

To change the DVD regional codes see “Changing DVD Regional Codes” on page 1 - 17.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

*Table 2 - 1: DVD Regional Coding*
Features & Components

2 - 6 7-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the Card Reader driver (see “CardReader” on page 4 - 6).

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS Pro (Memory Stick Pro)
- MS Duo (requires PC adapter*)
- Mini SD (requires PC adapter*)
- RS MMC (requires PC adapter*)

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover
Make sure you keep the rubber cover provided in the card reader when not in use. This will help prevent foreign objects and/or dust getting in to the card reader.

Figure 2 - 3
Right View
1. Card Reader
ExpressCard Slot

The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC Cards). Make sure you install the Card Reader driver (see “CardReader” on page 4 - 6).

ExpressCard/54 is used for applications which require a larger interface slot, e.g. CompactFlash card reader. The number denotes the card width; 54mm for the Express Card/54 and 34mm for the ExpressCard/34.

Inserting and Removing ExpressCards

• Align the ExpressCard with the slot and push it in until it locks into place (as pictured in the generic figure below).
• To remove an ExpressCard, simply press the card to eject it.

ExpressCard Slot Cover

Make sure you keep the rubber cover provided in the ExpressCard slot when not in use. This will help prevent foreign objects and/or dust getting in to the Express-Card Slot.

Figure 2 - 4
Left View
1. Express Card Slot

Figure 2 - 5
Inserting & Removing Express Cards
**Features & Components**

### TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse.

Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you can configure the functions by double-clicking the TouchPad driver icon on the taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences. You will find further information at www.synaptics.com.

---

**Figure 2 - 6**

Mouse Properties

---

2 - 8 TouchPad and Buttons/Mouse
Audio Features

You can configure the audio options on your computer from the Sound control panel in Windows, or from the Realtek HD Audio Manager icon in the taskbar/control panel (right-click the taskbar icon to bring up an audio menu). The volume may also be adjusted by means of the $\text{Fn} + \text{F5/F6}$ key combination.

Sound Volume Adjustment

The sound volume level is set using the volume control within Windows (and the volume function keys on the computer). Click the volume icon in the taskbar to check the setting.

Figure 2-7
Realtek Audio Manager

Right-click the icon to access the menu above.
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer; however it is always best to refer to the printer manual for specific instructions and configuration options.

USB Printer

Most current printers have a USB interface connection. You may use any one of the ports to connect the printer.

Install Instructions:

1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer's USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar, however you will need to purchase a parallel to USB converter.

Parallel Printer

After setting up the printer attach the parallel cable to the printer.

Connect the printer's parallel cable to the Parallel to USB converter, and then plug the converter into the USB port.

Turn ON the printer, then turn ON the computer.

Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system. This chapter covers:

- The Power Sources
- Turning on the Computer
- Power Plans
- Power-Saving States
- Configuring the Power Buttons
- Battery Information

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user’s manual of your operating system.

(Note: All pictures used on the following pages are from the Windows Vista OS.)

Hibernate Mode In Windows Vista SP1

If you are using Windows Vista SP1 with 4GB RAM installed, see page 8 - 12 for information on Hibernate.
The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page 3 - 14).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 10.
Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will force the computer to shut down). Use Power Options (Hardware and Sound menu) control panel in Windows Vista to configure this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 seconds. You may configure the options for the power button from the Power Options (Hardware and Sound menu) control panel in Windows Vista (see your OS’s documentation, or “Configuring the Power Buttons” on page 3 - 8 for details).
Power Management

3 - 4 Power Plans

The computer can be configured to conserve power by means of power plans. You can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to access further configuration options in Advanced Settings.

Password

It is recommended that you enable a password on system resume in order to protect your data.

Figure 3 - 1
Power Plan
Advanced Settings

Resuming Operation

See Table 3 - 1, on page 3 - 9 for information on how to resume from a power-saving state.
Each *Windows power plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose **High performance** for maximum performance when the computer is powered from an AC power source. Choose the **Power saver** (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.
Power Management

Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where you left off. **Sleep** is the default power-saving state in *Windows Vista*.

Earlier versions of *Windows* used Stand By and Hibernate as system power-saving states. *Windows Vista* combines the features of Stand By and Hibernate into the default **Sleep** power-saving state.

**Sleep**

In **Sleep** all of your work, settings and preferences are saved to memory before the system sleeps. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter **Sleep** to save power.

The PC wakes from **Sleep within seconds** and will return you to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

If your mobile PC in **Sleep** is running on battery power the system will use only a minimum amount of power. After an extended period the system will save all the information to the hard disk and shut the computer down before the battery becomes depleted.

---

3 - 6 Power-Saving States
Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves all of your information on a part of the hard disk before it turns the system off. If a power failure occurs the system can restore your work from the hard disk; if a power failure occurs when work is saved only to memory, then the work will be lost. Hibernate will also return you to where you last left off within seconds. You should put your mobile PC into Hibernate if you will not use the computer for a period of time, and will not have the chance to charge the battery (see “The Hibernate function has disappeared.” on page 8 - 12 if you cannot see the Hibernate function in Windows Vista SP1).

Shut Down

You should shut down the computer if you plan to install new hardware (don’t forget to remove the battery and follow all the safety instructions in Chapter 6), plan to be away from the computer for several days, or you do not need it to wake up and run a scheduled task. Returning to full operation from shut down takes longer than from Sleep or Hibernate.

Silent Mode

You can use Silent Mode to reduce power consumption and fan noise.

Use the Silent Mode hot key to toggle this mode on/off.

On screen visual indicators and the LED indicator will display the Silent Mode status (see Table 1 - 3, on page 1 - 11 and Table 1 - 5, on page 1 - 14).

Note Silent Mode may reduce computer performance.

Figure 3 - 3
Lock Button menu
Power Management

Configuring the Power Buttons

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer into a power-saving state.

Password Protection

It is recommended that you enable a password on wake up in order to protect your data.

However you can disable this setting from the Power Options menu by clicking Require a password on wakeup in the left menu, and selecting the options (click Change settings that are currently unavailable).

Figure 3-4
Power Options
Define Power Buttons

3 - 8 Configuring the Power Buttons
Resuming Operation

You can resume operation from power-saving states by pressing the power button, or in some cases pressing the sleep button (Fn + F4 key combo).

<table>
<thead>
<tr>
<th>Power Status</th>
<th>Icon</th>
<th>Color</th>
<th>To Resume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Off</td>
<td>Off</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Sleep</td>
<td>Blinking Green</td>
<td></td>
<td>Press the Power Button Press the Sleep Button (Fn + F4 Key Combo)</td>
</tr>
<tr>
<td>Hibernate</td>
<td>Off (battery)</td>
<td>Orange (AC/DC adapter)</td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Display Turned Off</td>
<td>Green</td>
<td></td>
<td>Press a Key or Move the Mouse/Touchpad</td>
</tr>
</tbody>
</table>

Table 3 - 1
Resuming Operation

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down hot key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will force the computer to shut down).
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon in the taskbar to see the current battery level and charge status.

Figure 3 - 5
Battery Icon (Taskbar) & Battery Advanced Settings
Conserving Battery Power

- Use a **power plan** that conserves power (e.g. **Power saver**), however note that this may have an affect on computer performance.

- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.

- Reduce the amount of time before the display is turned off.

- Close wireless, Bluetooth, modem or communication applications when they are not being used.

- Disconnect/remove any unnecessary external devices e.g. USB devices, ExpressCards etc.

---

**Figure 3 - 6**

**Windows Mobility Center**

The **Windows Mobility Center** control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.
Power Management

Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “- LED Status Indicators” on page 1 - 11 for information on the battery charge status, and to “Battery Information” on page 3 - 10 for more information on how to maintain and properly recharge the battery pack.)
Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

**Caution**

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.

**Damaged Battery Warning**

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power settings.
4. Scroll down to **Battery** and click + to expand the battery options.
5. Choose the options below (click **Yes** if a warning appears):

- Low battery levels = 0%
- Critical battery Levels = 0%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing
How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

What to Install

The Device Drivers & Utilities + User’s Manual disc contains the drivers and utilities necessary for the proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install and it is very important that the drivers are installed in the order indicated (see “Driver Installation” on page D - 27 for Windows XP information).

Module Driver Installation

The procedures for installing drivers for the Wireless LAN, PC Camera, 3.5G, Fingerprint, and Intel Turbo Memory modules are provided in “Modules & Options” on page 7 - 1.
Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc and click **Install Drivers/Option Drivers** (button).

If you wish to install the drivers manually see overleaf for the driver path information.

1. Check the driver installation order from **Table 4 - 1, on page 4 - 3** (the drivers must be installed in this order) which is the same as that listed in the **Drivers Installer** menu below.
2. Click to select the driver you wish to install, after installing each driver it will become grayed out (if you need to reinstall any driver, click the **Unlock** button).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.
Manual Driver Installation

Click *Browse CD* (button) in the *Drivers Installer* application and browse to the executable file in the appropriate driver folder.

**Windows Update**

After installing all the drivers make sure you enable **Windows Update** in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft). See “**Windows Update**” on page 4 - 6 for instructions.

<table>
<thead>
<tr>
<th>Driver - <em>Windows Vista</em> with Service Pack 1</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>Video</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>Modem</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>LAN</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>TouchPad</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>CardReader</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Hot Key</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Wireless LAN Module</td>
<td>Page 7 - 6</td>
</tr>
<tr>
<td>PC Camera Module</td>
<td>Page 7 - 12</td>
</tr>
<tr>
<td>3.5G Module</td>
<td>Page 7 - 20</td>
</tr>
<tr>
<td>Fingerprint Reader Module</td>
<td>Page 7 - 30</td>
</tr>
<tr>
<td>Intel Turbo Memory Module</td>
<td>Page 7 - 34</td>
</tr>
</tbody>
</table>

*Table 4 - 1 - Driver Installation*

*Windows Vista Service Pack 1*

Make sure you install **Windows Vista Service Pack 1** (or a Windows Vista version which includes Service Pack 1) **before installing any drivers**. Go to the Microsoft website for download details, or contact your service center.
Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Programs and Features icon (Programs > Uninstall a program). Click to select the driver (if it is not listed see below) and click Uninstall, and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the Programs and Features menu:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Device Manager (Hardware and Sound > Device Manager).
3. Double-click the device you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click Driver (tab) and click the Update Driver or Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)

If a User Account Control prompt appears as part of the driver installation procedure, click Continue or Allow, and follow the installation procedure as directed.

Windows Security Message

If you receive a Windows security message as part of the driver installation process. Just click “Install this driver software anyway” or Install to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found” during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.
Driver Installation Procedure

Insert the *Device Drivers & Utilities + User's Manual* disc and click *Install Drivers* (button), or click *Option Drivers* (button) to access the optional driver menu.

**Chipset**
1. Click **1.Install Chipset Driver > Yes.**
2. Click **Next > Yes > Next > Next.**
3. Click **Finish.**

**Video**
1. Click **2.Install Video Driver > Yes.**
2. Click **Next > Yes > Next > Next.**
3. Click **Finish** to restart the computer.

**Audio**
1. Click **3.Install Audio Driver > Yes.**
2. Click **Next.**
3. Click **Finish** to restart the computer.

**Modem**
1. Click **4.Install Modem Driver > Yes.**
2. Click **OK.**
3. The modem is ready for dial-up configuration.

Modem Country Selection

Go to the *Phone and Modem Options* control panel (Hardware and Sound) and make sure the modem country selection is appropriate for you.

**LAN**
1. Click **5.Install LAN Driver > Yes.**
2. Click **Next > Install.**
3. Click **Finish.**
4. The network settings can now be configured.
Drivers & Utilities

**TouchPad**
1. Click **6. Install Touchpad Driver > Yes**.
2. Click **Next**.
3. Click **Finish > Restart Now** to restart the computer.

**CardReader**
1. Click **7. Install CardReader Driver > Yes**.
2. Click **Next > Install**.
3. Click **Finish**.

**Hot Key**
1. Click **8. Install Hotkey Driver > Yes**.
2. Click **Next > Install**.
3. Click **Finish > Finish** to restart the computer.

---

**Windows Update**

After installing all the drivers make sure you enable Windows Update in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft).

To enable Windows Update make sure you are connected to the internet:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Click **Check for updates (Security)**, or double-click Security Center and click Windows Update.
3. Double-click **Check for updates (button)**.
4. The computer will now check for updates (you need to be connected to the internet).
5. Click **Install now (button)** to install the updates.
Optional Drivers
See the pages indicated for the driver installation procedures for any modules included in your purchase option.

Figure 4 - 3 - Drivers Installer - Option Drivers Menu

Bluetooth Module
Note: The operating system is the default setting for Bluetooth control in Windows Vista, and does not require a driver. See “Bluetooth Module” on page 7 - 2 for configuration instructions.

Wireless LAN Module
See the introduction in “Wireless LAN Module” on page 7 - 6, and check the installation procedure.

PC Camera Module
See the introduction in “PC Camera Module” on page 7 - 12, and check the installation procedure.

3.5G Module
See the introduction in “3.5G Module” on page 7 - 20, and check the installation procedure.

Fingerprint Reader Module
See the introduction in “Fingerprint Reader Module” on page 7 - 30, and check the installation procedure.

Intel Turbo Memory Technology Driver
See the introduction in “Intel Turbo Memory Module” on page 7 - 34, and check the installation procedure.
Chapter 5: BIOS Utilities

Overview
This chapter gives a brief introduction to the computer’s built-in software:

Diagnostics: The POST (Power-On Self Test)

Configuration: The Phoenix Setup utility
If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you are doing. Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.

Warning
Incorrect settings can cause your system to malfunction. To correct mistakes, return to Setup and restore the Setup Defaults with <F9>.
The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load the operating system. Once that starts, you can’t get into Setup without rebooting.

POST Screen

1. BIOS information
2. CPU type
3. Memory status
4. Enter Setup prompt appears only during POST

Note: The POST screen as pictured right is for guideline purposes only. The POST screen on your computer may appear slightly different. If you disable the Boot-time Diagnostic Screen, the POST screen will not appear.

Figure 5-1
POST Screen

Phoenix SecureCore(tm) NB
Copyright 1985-2007 Phoenix Technologies Ltd.
All Rights Reserved

Bios Revision: ********
KBC/EC Firmware Revision: ********

CPU = 1 Processors Detected, Cores per Processor = 2
Intel(R) Core(TM)2 Duo CPU P8600 @ 2.40GHz
2036M System RAM Passed
System BIOS shadowed
Video BIOS shadowed
Fixed Disk 0: FUJITSU MHY2080BH
ATAPI CD-ROM: TSSTcorp CDDVDW TS-L633A
Mouse initialized

Press <F2> to enter SETUP
Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

- Press <F1> to resume
- <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Utility

The Phoenix Setup Utility tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt (Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then hold down F2 when prompted. The Setup main menu will appear.
Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the screen. If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ► next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., \(0\) = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
**SATA Port 1 (Main Menu)**
Pressing **Enter** opens the sub-menu to show the configuration of a HDD on the computer’s Serial ATA Port 1. Use the **Auto** (Type:) setting to have the items configured automatically for you.

**SATA Port 2 (Main Menu)**
Pressing **Enter** opens the sub-menu to show the configuration of an optical Device on the computer’s Serial ATA Port 2. Use the **Auto** (Type:) setting to have the items configured automatically for you.

**System/Extended Memory (Main Menu)**
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.
Advanced Chipset Control (Advanced Menu)

The sub-menu here allow you to Enable/Disable detection for External CRT’s (external displays). You can disable detection to save system power.
Installed O/S (Advanced Menu)
This setting tells the computer what kind of operating system you’re using. Make sure you choose the correct setting for your O/S in order to prevent system problems. Note: If you select the Vista O/S then the SATA Mode Selection menu will become available. If you are installing the Windows XP O/S make sure you have set the appropriate operating system here in order to prevent system problems.

SATA Mode Selection (Advanced Menu)
This menu is only available if you select the Vista O/S as your operating system. You can configure SATA (Serial ATA) control to operate in either IDE (native/compatible) or AHCI (Advanced Host Controller Interface) modes from this menu. The SATA mode should be set to AHCI mode for this system (unless you are sure your hard disk can only operate in IDE mode). If you are unsure of the mode your hard disk supports contact your service center.

DFOROM (Robson) Support (Advanced Menu > SATA Mode Selection [AHCI])
This item will only be available if you have selected AHCI in SATA Mode Selection. The option should be enabled only if you have included an optional Intel Turbo Memory Module in your purchase configuration. You should then install the driver as per the instructions in “Intel Turbo Memory Module” on page 7 - 34.
Reset Configuration Data (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have installed a new add-on which has reconfigured the system, resulting in such a serious system conflict that the operating system is unable to boot.

Boot-time Diagnostic Screen (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen or POST screen (see “The Power-On Self Test (POST)” on page 5 - 2).

Legacy OS Boot (Advanced Menu)
If “Enabled” the system will attempt to load the Legacy OS (e.g. Vista/Windows XP) first. If set to “Disabled” the system will attempt to EFI (Extensible Firmware Interface) boot before the Legacy OS.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the audible warning when the battery has reached low power status.

Fan Control (Advanced Menu)
This menu item allows you to set the fan cooling behavior under light system activity (if you choose Automatic the system will adjust the fan cooling as appropriate for the system activity).
Set Supervisor Password (Security Menu)
You can set a password for access to the Phoenix SecureCore Setup Utility. This will not affect access to the computer OS (only the Phoenix SecureCore Setup Utility).
Set User Password (Security Menu)
You can set a password for user mode access to the Phoenix SecureCore Setup Utility. This will not affect access to the computer OS, (only the Setup utility) unless you choose to set a Password on Boot (see below). Many menu items in the Phoenix SecureCore Setup Utility cannot be modified in user mode. You can only set the user password after you have set the supervisor password.

Fixed disk boot sector (Security Menu)
If you choose “Write-Protect” this will protect against viruses being written to the hard disk boot sector (this is not a substitute for installing an anti-virus program - see “Viruses” on page 8 - 4).

Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may only set a password on boot if a supervisor password is enabled). If “Enabled” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then press Enter for the new password (without typing any password entry) and Enter again to confirm the password clearance.
Boot Menu

When you turn the computer on it will look for an operating system (e.g. *Windows Vista*) from the devices listed in this menu, and **in this priority order**. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the **Boot priority order**. Item specific help on the right is available to help you move devices up and down the order.

**Figure 5 - 5**

**Boot Menu**

<table>
<thead>
<tr>
<th>Boot priority order:</th>
<th>Item Specific Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>1: USB KEY:</td>
<td>Keys used to view or configure devices:</td>
</tr>
<tr>
<td>2: IDE FDC:</td>
<td>Up and Down arrows select a device.</td>
</tr>
<tr>
<td>3: IDE CD: Optiarc CDRW/DVD CRX890S-(P)</td>
<td>&lt;-&gt; and &lt;-&gt; moves the device up or down.</td>
</tr>
<tr>
<td>4: USB CDROM:</td>
<td>&lt;f&gt; and &lt;r&gt; specifies the device fixed or removable.</td>
</tr>
<tr>
<td>5: IDE HDD: FUJITSU MHY2080BH-(PM)</td>
<td>&lt;x&gt; exclude or include the device to boot.</td>
</tr>
<tr>
<td>6: PCI BEV: Realtek Boot Agent</td>
<td>&lt;Shift + l&gt; enables or disables a device.</td>
</tr>
<tr>
<td>7: IDE HDD:</td>
<td>&lt;1 - 4&gt; loads default boot sequence.</td>
</tr>
<tr>
<td>8:</td>
<td>Excluded from boot order:</td>
</tr>
<tr>
<td></td>
<td>USB ZIP:</td>
</tr>
<tr>
<td></td>
<td>USB LS120:</td>
</tr>
<tr>
<td></td>
<td>PCI SCSI:</td>
</tr>
<tr>
<td></td>
<td>Other USB:</td>
</tr>
<tr>
<td></td>
<td>PCI:</td>
</tr>
<tr>
<td></td>
<td>Legacy</td>
</tr>
</tbody>
</table>

**Keys used to view or configure devices:**

- Up and Down arrows select a device.
- <-> and <-> moves the device up or down.
- <f> and <r> specifies the device fixed or removable.
- <x> exclude or include the device to boot.
- <Shift + l> enables or disables a device.
- <1 - 4> loads default boot sequence.
Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

- A small crosshead or Phillips screwdriver
- A small regular slotted (flathead) screwdriver
- An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

- Removing the Battery
- Upgrading the Hard Disk Drive
- Upgrading the Optical (CD/DVD) Device
- Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.
When Not to Upgrade

These procedures involve opening the system’s case, adding and sometimes replacing parts.

You should not perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

Power Safety Warning

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery.

1. Turn the computer off, and turn it over.
2. Slide the latch 1 in the direction of the arrow.
3. Slide the latch 2 in the direction of the arrow, and hold it in place.
4. Slide the battery out in the direction of the arrow 3.

Warranty Warning

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

Figure 6 - 1
Battery Removal
Upgrading the Hard Disk Drive

The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5mm (h) (see “Storage” on page C - 2). Follow your operating system’s installation instructions, and install all necessary drivers and utilities (see “Driver Installation” on page 4 - 2), when setting up a new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and loosen screws 1 & 2.
3. Remove the hard disk bay cover 3.
4. Grip the tab and slide the hard disk in the direction of arrow 4.

Figure 6 - 2
Hard Disk Bay & Screws

New HDD’s are blank. Before you begin make sure:
You have backed up any data you want to keep from your old HDD.
You have all the CD-ROMs and FDDs required to install your operating system and programs.
If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.
5. Lift the hard disk up in the direction of arrow 5.
6. Remove the screws 6 & 7 and cover 8.
7. Reverse the process to install a new hard disk drive.

Figure 6 - 3
HDD & Cover Removal
Upgrading The Computer

Upgrading the Optical (CD/DVD) Device

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the RAM & CPU bay cover and remove screws 1 - 4.
3. Carefully (a fan and cable are attached to the under side of the cover) lift up the bay cover.
4. Remove the screw at point 5, and use a screwdriver to carefully push out the optical device at point 6.
5. Reverse the process to install the new device.

Figure 6 - 4
Removing the CD/DVD Device
Upgrading the System Memory (RAM)

The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-DIMM) DDR II (DDR2) type memory modules (see “Memory” on page C - 2 for details of supported module types).

The total memory size is automatically detected by the POST routine once you turn on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the RAM & CPU bay cover and remove screws 1 - 4.
Upgrading The Computer

3. Carefully (a fan and cable are attached to the under side of the cover) lift up the bay cover.

4. Carefully disconnect the fan cable (5), and remove the cover (6).

5. Gently pull the two release latches on the sides of the memory socket in the direction indicated by the arrows (7 & 8) in Figure 6 - 7.

Contact Warning
Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.
6. The RAM module will pop-up, and you can remove it.

7. Pull the latches to release the second module if necessary.
8. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory slot.
9. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit without much pressure.
10. Press the module in and down towards the mainboard until the slot levers click into place to secure the module.
11. Replace the bay cover and screws (make sure you reconnect the fan cable before screwing down the bay cover - see Figure 6 - 6 on page 6 - 8).
12. Restart the computer to allow the BIOS to register the new memory configuration as it starts up.
Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.

Unauthorized tampering with the HDD may also violate your warranty.
Chapter 7: Modules & Options

Overview

This chapter contains information on the following modules, which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

- Bluetooth Module
- Wireless LAN Module
- PC Camera Module
- 3.5G Module
- Fingerprint Reader Module
- Intel Turbo Memory Module

Important Notice

If your purchase option includes both Wireless LAN and 3.5G modules, then the appropriate antennas will be installed. Note that in order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in conjunction with any other antenna or transmitter.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.
Bluetooth Module

The operating system’s Bluetooth Devices control panel is used to configure the Bluetooth settings in Windows Vista, and therefore does not require a driver. Use the Fn + F12 key combination (see “Function/Hot Key Indicators” on page 1 - 14) to toggle power to the Bluetooth module.

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard an aircraft.

Use the Fn + F12 key combination to toggle power to the Bluetooth module, and check the LED indicator to see if the module is powered on or not (see Table 1 - 5, on page 1 - 14 / Table 1 - 3, on page 1 - 11).

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported). Therefore if you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use the key combination (Fn + F12) to power on the Bluetooth module after the computer resumes from Sleep.
Bluetooth Configuration in Windows Vista

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module.
2. A Bluetooth icon will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control panel.
   • Double-click the icon to access the Bluetooth Devices control panel.
   • Click Start, and click Control Panel (or point to Settings and click Control Panel), and then click Bluetooth Devices (Hardware and Sound).
   • Click/Right-click the icon and choose an option from the menu.

If you cannot see the Bluetooth icon in the taskbar, access the Bluetooth Devices control panel. Click Options (tab), and make sure that Show Bluetooth icon in the notification area check box has a tick inside it. Note that you will need to check the LED indicator to see if the module is powered on or not.
To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to this computer check box (Connections) has a tick inside it.
3. Click Devices (tab), and then click Add.
5. Click to select “My device is set up and ready to be found”, and then click Next.
6. The Wizard will then search for any available Bluetooth devices within range.
7. Click to select the device you want to communicate with, and click Next.
8. Select an appropriate passkey option and click Next.
9. Click Finish.
To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:
   • Change the name of the device (click General, type a new name and click OK).
   • Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Allow Bluetooth devices to find this computer check box (Discovery) has a tick inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check box (Connections) has a tick inside it, if you want to be notified when a Bluetooth device wants to connect.

Bluetooth Help
To get help on Bluetooth configuration and settings, select Help and Support from the Start menu. Type Bluetooth in the Search Help box, and select an item from the returned search results to get more information.
Wireless LAN Module

If you have included an Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) WLAN or 3rd Party 802.11 b/g WLAN module in your purchase option, make sure that the Wireless LAN module is on before installing the driver.

Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 7 - 14) to toggle power to the Wireless LAN module. Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Finish.

Note: The operating system is the default setting for Wireless LAN control in Windows Vista (see page 7 - 8).

Note: The Intel® Wi-Fi Link 5300 Series WLAN module is not available as an option for Model B computers with an LED Backlight LCD.
802.11 b/g WLAN Driver Installation

1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Windows Vista (see overleaf).
Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. **Click** the taskbar wireless icon 📱, and then click **Connect to a network** (or right-click the icon 📱, and then click **Connect to a network**).

2. In the **Show** list, click to choose **Wireless** from the drop-down menu.

3. A list of currently available networks will appear.
4. Click a network, and then click **Connect**.
5. If you do not see a network you want to connect to, click **Set up a connection or network** (a list of options will appear allowing manual searching, and creating a new network).

![Connecting](image1.png)

6. Move the cursor over the taskbar icon to see the connection status (see below).

![Connection Status](image2.png)
7. To disconnect from the wireless network you can click the taskbar wireless icon, and then select **Connect or disconnect** to access the network menu, and click **Disconnect** (or right-click the icon, and then click **Disconnect from**).
Windows Mobility Center

The **Windows Mobility Center** control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Double-click **Windows Mobility Center (Mobile PC)**.
3. Click the button to **Turn wireless off/on**, or click the icon ![icon] to access the network menu.

![Windows Mobility Center](image)

*Figure 7 - 10 Windows Mobility Center*
PC Camera Module

The PC Camera module uses the **BisonCap** application to capture video files and to take pictures. Before installing the driver, make sure that the optional PC Camera is on.

Use the Fn + F10 key combination (see “Function/Hot Key Indicators” on page 1 - 14) to toggle power to the PC Camera module. Make sure you install the drivers in the order indicated in *Table 4 - 1, on page 4 - 3*.

**Note:** The 2.0M Pixel PC Camera module is not available as an option for **Model B** computers with an LED Backlight LCD.
PC Camera Driver Installation

1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers** (button).
3. Click **2.Install Camera Driver > Yes**.
4. Choose the language you prefer and click **Next > Next**.
5. Click **Finish** to restart the computer.
6. Run the **BisonCap** application program from the **BisonCam** shortcut on the desktop, or from the **BisonCam** item in the **Start > Programs/All Programs** menu (if the hardware is turned off use the **Fn + F10** key combination to turn it on again).

---

2.0M PC Camera Screen Refresh

The 2.0M PC Camera module supports a frame rate of 12 fps. If you find that the screen refresh rate is subject to lag or stuttering, then reduce the window size, or adjust the **Output Size** and/or **Color Space Compression**.

To reduce **Output Size** and/or **Color Space Compression** run the **BisonCap** application, click **Options** and select **Video Capture Pin**. Adjust the settings from the appropriate pull-down menu.
PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Click **Sound** (Hardware and Sound).
3. Click **Recording** (tab).
4. Right-click **Microphone** (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click **Microphone** (or select **Properties** from the right-click menu).
6. Click **Levels** (tab), and adjust the **Microphone** and **Microphone Boost** sliders to the level required.
7. Click **OK** and close the control panels.
8. Run the **BisonCap** application program from the **Start > Programs/All Programs > BisonCam** menu.
9. Go to the **Devices** menu heading and select **Microphone** (Realtek....) (it should have a tick alongside it).
10. Go to the **Capture** menu heading and select **Capture Audio** (it should have a tick alongside it).
Figure 7 - 11
Audio Setup for PC Camera

Right-click
BisonCap

BisonCap is a video viewer for general purpose video viewing and testing, and for capturing video files to .avi format.

1. Run the BisonCap program from the Start > Programs/All Programs > Bison-Cam menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page 7 - 14) and select Start Capture.
3. Click OK (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to stop the capture (you can view the file using the Windows Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the "Capture file size:" and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page 7 - 17 in order to save file space, and help prevent system problems.
Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on the C: drive system partition. In order to prevent system problems it is recommended that you save the captured video file to a location other than the C: drive (see “Set Capture File” on page 7 - 16), limit the file size of the captured video (see “Pre-Allocating File Space” on page 7 - 16) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
Eliminating Screen Flicker
If you find that the video screen in the BisonCap program is flickering, you can try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).
Zoom
The **BisonCap** program allows you to zoom the camera in and out.

1. Run the **BisonCap** program.
2. Go to **Zoom** and select **Zoom Out/Zoom In**.

Taking Still Pictures
The **BisonCap** program allows you to take still pictures.

1. Run the **BisonCap** program.
2. Go to **Options** and select **Take Picture**.
3. The picture (in JPEG format) will be placed in the **Snapshot** folder on the desktop.
3.5G Module

If you have included an optional 3.5G module (see “Communication” on page A - 4 for specification details) in your purchase option, you will have the appropriate software provided for your module. Follow the instructions below to install the USIM card (which will be provided by your service provider), and then install the application.

Before installing the application, make sure that the 3.5G module is on. Use the **Fn+[^] key combination** (see “Function/Hot Key Indicators” on page 1 - 14) to **toggle power to the 3.5G module**. Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and loosen screws 1 & 2.
3. Remove the hard disk bay cover 3.
4. Grip the tab and slide the hard disk in the direction of arrow 4 to remove it.

**Figure 7 - 14**
Hard Disk Removal
5. Insert the USIM card as you would into your mobile phone.
6. The 3.5G module is pictured on the left, and the installed USIM card on the right in Figure 7 - 15.

7. Slide the SIMLOCK in the direction of the arrow (Figure 7 - 16) in order to release the lock and lift it up.
8. Insert the USIM card as illustrated in *(Figure 7 - 17)* and close the SIMLOCK.

![Insert the USIM Card](image1)

*(Figure 7 - 17)*  
Insert the USIM Card

9. Close the SIMLOCK by pushing it in the direction of the arrow in *(Figure 7 - 18)*.

![SIMLOCK Lock](image2)

*(Figure 7 - 18)*  
SIMLOCK Lock

10. Replace the hard disk assembly, cover, screws and battery etc.
3G Watcher Application
With the 3.5G module and USIM card (provided by your service provider) installed you may then install the 3G Watcher application. The 3.5G Watcher application allows you to directly access your 3.5G internet service from the computer.

3G Watcher Application Installation
1. Enable power to the module by pressing the **Fn + 📻** key combination (the icon 📲 will be green).
2. If a *Found New Hardware Wizard* appears, click **Cancel**.
3. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
4. Click **Option Drivers** (button).
5. Click **3.Install 3G Driver > Yes**.
6. Click **Next**.
7. Click the button to accept the license agreement, and then click **Install**.
8. When the next screen appears **wait (about 2 minutes) until the 3G Watcher application appears on screen** (as per *Figure 7 - 19*) before clicking **Finish** (this allows the hardware to detect the 3.5G module).

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the **Fn + 📻** key combination to toggle power to the 3.5G module, and check the indicator to see if the module is powered on or not (see *Table 1 - 5*, on page 1 - 14/*Table 1 - 3*, on page 1 - 11).

*Figure 7 - 19*
3G Watcher Application
Setting Up a Carrier Profile

Although the connection information is stored on the USIM card supplied by the service provider, you will need to set up the appropriate carrier profile from the 3G Watcher software.

1. Power on the 3.5G module using the Fn + key combination (the icon will be green).
2. Access the 3G Watcher application from the Start menu (Start > Programs/All Programs > Sierra Wireless > 3G Watcher), or by clicking the desktop icon.
3. Click Tools and select Options.
4. Click Profiles and then click the Add new profile button, and select WWAN profile.

Figure 7 - 20
Add WWAN Profile
5. You can then enter a new profile name or choose a profile from the drop-down list provided by the software (see the sidebars for information on the profile details).

6. Click **Apply > OK** to save the information.

7. You can choose the profile from the pull-down menu.

---

**Profile Information**

Click **General** and/or **Advanced** (and the sub-menus under Advanced) in the left menu, and then click in any of the fields to add the appropriate information supplied by your service provider.

**Profile Details**

If you have chosen the profile from the drop-down list then most of the information in the **General** and **Advanced** tabs should be automatically filled in for you (however check with your service provider for the latest information as you may at least need to add in your Username and Password).
Connecting to the Service Provider

1. Power on the 3.5G module using the **Fn + ** key combination (the icon will be green).
2. You can access the **3G Watcher** application from the **Start** menu (**Start > Programs/All Programs > Sierra Wireless > 3G Watcher**), or by clicking the desktop icon .
3. The software will run and display the service provider name (see “Setting Up a Carrier Profile” on page 7 - 24).

**Figure 7 - 23**
Connect Button

4. Click **Connect** to begin the connection process.
5. The **3G Watcher** application will then display the connection information in the window.

**Figure 7 - 24**
Connecting
6. When the connection is successful a taskbar notification will appear (as below).

7. You can then access the internet, download e-mail etc. as per any internet connection.
8. While you are connected the taskbar icon will be green (it will be red when the program is running but not connected).
9. To disconnect click the **Disconnect** icon.

10. The program will disconnect from the service provider.
11. The module will still be on, and you will need to press the **Fn + ✪** key combination (the icon ✪ will be off when disconnected).
12. If you click the **3G Watcher** close icon a message will be displayed asking you to click **OK** to confirm the program exit.

![Exit Warning](image)

**Figure 7 - 27**
Exit Warning

13. Exiting the program DOES NOT turn off the 3.5G module, and you will need to press the **Fn +** key combination to turn off the module (pay careful attention to this aboard aircraft - see “Wireless Device Operation Aboard Aircraft” on page 7 - 23).

14. If the module is on and the computer enters a power-saving state, then the power status of the module on resuming from the power-saving state will be as below:

- If the 3.5G module is on and the computer is **Shut Down or Restarted**; the module will be **off** when the computer starts up.
- If the 3.5G module is on and the computer enters **Sleep or Hibernate**; the module will be **off** when the computer resumes from sleep.
Short Messaging Service
In addition to standard internet services you may also send and receive SMS text messages using the 3G Watcher program, if your service supports SMS.

Reading SMS Messages
1. The SMS message indicator in the main window will notify you of any new messages received.
2. Double-click the icon or select Tools > SMS Express.
3. Select the inbox folder and select any message to read it.
4. You cannot receive any new messages if the USIM card becomes full so you will need to delete some of the messages in order to free up space on the USIM card.

Creating and Sending SMS Messages
1. Double-click the icon or select Tools > SMS Express.
2. Select File > New Message or click the New button.
3. Enter the recipient’s number in the To.. field or click the To.. button to select an entry from the phone book, and click the Message button.
4. Type in the message details in the message body area.
5. Click the Send button (or save the message to send later).

For more details on SMS see 3GWatcher Online Help from the Help > Help Topics menu.
Fingerprint Reader Module

If you have included the fingerprint reader in your purchase option you will need to install the driver as per the instructions below.

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the fingerprint tutorial. To run the tutorial click Start > Programs/All Programs > Protector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install Fingerprint Driver > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.
User Enrollment

1. Click **Start > Programs/All Programs > Protector Suite QL > User Enrollment**, or double click the taskbar icon.
2. On the first run of the program you will be asked to click the button to accept the license, and then click **OK**.
3. Click **Next** and select “**Enrollment to the hard disk**”, and click **Finish**.

4. If you have not set a **Windows** password you will be prompted to do so (**note**: If you have not set a password **Protector Suite QL** cannot secure access to your computer).
5. Click **Next**.
6. You will then be prompted to enter your **Windows** password.
7. Click **Next > Next** (if you have the **“Run interactive tutorial”** tickbox selected you will run through the Fingerprint Tutorial).
8. Click **Next** for each window of the tutorial (you can click the button to **“skip tutorial”** at any time).
9. Click the button above any of the fingers to begin the enrollment process for that finger.
10. Swipe the finger three times to enroll that finger.
11. Repeat the process for all the fingers you wish to enroll (see sidebar), and then click **Next**.
12. Click **Finish**.
13. Click any of the headings under “Learn more about:” to get more information on any topic.
14. Click **Close**.

---

**Fingerprint Enrollment**

Note that it is strongly recommended that you enroll more than one finger in case of injury etc.

Figure 7 - 29

Fingerprint Enrollment

---

7 - 32 Fingerprint Reader Module
15. Right-click the taskbar icon to bring up the menu that allows you to Edit Fingerprints, Start Control Center, access the Help menu etc. You can also run the Control Center etc. from the Protector Suite QL item in the Programs/All Programs menu.


17. If you swipe your finger over the reader at any time you can access the Biomenu to lock the computer, register websites, open the Control Center and access the Help menu.

18. The Control Center allows you to change the Settings, enroll Fingerprints and get Help.
Intel Turbo Memory Module

If you have included an Intel Turbo Memory (Robson) NAND flash memory card module in your purchase option, then you will need to install the driver as per the instructions below (do not install this driver in Windows XP).

**Intel Turbo Memory Technology** (also known as Robson flash memory) is an Intel technology that reduces the time it takes for a computer to boot up, to load applications, and to write data to the hard drive. **Intel Turbo Memory Technology** is supported in Windows Vista only (it also supports Windows Vista features such as ReadyBoost, ReadyDrive, and Superfetch).

**Intel Turbo Memory Driver Installation**

1. Start-up the computer and press <F2> to enter the BIOS (see “The Setup Utility” on page 5 - 4).
2. Go to the Advanced menu, select "Installed O/S" and make sure "Vista" is the selected option (see “Advanced Menu” on page 5 - 8).
3. Go to the "SATA Mode Selection" item and make sure "AHCI" is selected.
4. If "AHCI" is the selected mode then the "DFOROM (Robson) Support" item will be available.
5. Set the "DFOROM (Robson) Support" item to "Enabled".
6. Go to the Exit menu (see “Exit Menu” on page 5 - 14) and select "Exit Saving Changes" (or press F10 and select "Yes" then press Enter) and press Enter to exit the BIOS and reboot the computer.
7. Insert the **Device Drivers & Utilities + User’s Manual** disc into the CD/DVD drive.
8. Click **Option Drivers** (button).
9. Click **5. Install TurboMemory Driver > Yes**.
10. Click **Next > Yes > Next > Next**.
11. Click **Finish**.
12. Run the **Intel® Turbo Memory Console** from the Programs/All Programs menu (**Intel® Turbo Memory**).

- **Windows ReadyBoost** - uses flash memory as a hard-drive caching solution.
- **Windows ReadyDrive** - uses hybrid drives as a hard-drive caching solution.
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

• **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indicators” on page 1 - II) to see the computer’s power status.

• **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

• **Power Savings** - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys configured in your Power Options (see “Power-Saving States” on page 3 - 6), the Fn + F4 key combination, or power button to wake-up the system.

• **Brightness** - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness.

• **Display Choice** - Press Fn + F7 to make sure the system is not set to “external only” display.

• **Boot Drive** - Make sure there are no optical media and/or USB storage devices in any connected drive (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
Backup and General Maintenance

• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wallet.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a Supervisor password for the BIOS (see “The Power-On Self Test (POST)” on page 5 - 2).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
**Troubleshooting**

**Viruses**

- Install an *Anti-Virus* program and keep the *definitions file* (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. *Anti-Virus* programs are commercially available and the *definitions file updates* are usually downloadable directly from the internet.

- Be careful when opening e-mail from sources you don’t know. *Viruses* are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most *Anti-Virus* programs to check all e-mail attachments. *Note*: You should also beware of files from people you know as the virus may have infected an *address book* and been automatically forwarded without the person’s knowledge.

- Keep a “*Bootable CD-ROM/DVD-ROM/USB storage device*” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many *Anti-Virus* programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

- Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

- Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

- Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

- When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

- Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).
Troubleshooting

- Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.

- Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
## Troubleshooting

### Problems and Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned on the <strong>power</strong> but it doesn’t work.</td>
<td><em>Battery missing / incorrectly installed.</em> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The battery <strong>LED power</strong> indicator is blinking orange.</td>
<td><strong>Low Battery.</strong> Plug in the DC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are <strong>losing battery power</strong> too quickly.</td>
<td><em>The system is using too much power.</em> If your OS has a Power Options scheme (see “Power Plans” on page 3 - 4/“Power Schemes” on page D - 18) check its settings. You may also be using an ExpressCard/USB device/external device that is drawing a lot of power.</td>
</tr>
</tbody>
</table>
| Actual **battery operating time** is shorter than expected. | *The battery has not been fully discharged before being recharged.* Make sure the battery is fully discharged and recharge it completely before reusing (see “Battery Information” on page 3 - 10/“Battery Information” on page D - 23).  
*Power Options have been disabled.* Go to the **Control Panel** in Windows and re-enable the options.  
*A peripheral device/USB device/ExpressCard is consuming a lot of power.* Turn off/remove the unused device to save power. |
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels <strong>too hot</strong>.</td>
<td>Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1-18). Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vent/Fan intakes to be blocked.</td>
</tr>
</tbody>
</table>
| Nothing appears on screen.                    | **The system is in a power saving mode.** Toggle the sleep/resume key combination, **Fn + F4** (see “Configuring the Power Buttons” on page 3-8/“Configuring the Power Button” on page D-22).  
**The screen controls need to be adjusted.** Toggle the screen control key combinations **Fn + F8/F9.** If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls.  
**The computer is set for a different display.** Toggle the screen display key combination, **Fn + F7.** If an external monitor is connected, turn it on.  
**The screen saver is activated.** Press any key or touch the **TouchPad.** |
| No image appears on the **external monitor** I have plugged in and powered on. | **You haven’t installed the video driver and configured it appropriately from the Control Panel.** See “Attaching Other Displays” on page B-5/“Attaching Other Displays” on page D-11 for instructions on installing and configuring the video driver. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You forget the boot password.</td>
<td>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</td>
</tr>
</tbody>
</table>

### Password Warning
If you choose to set a boot password, **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The sound cannot be heard or the volume is very low.</td>
<td>The volume might be set too low. Check the volume control in the Volume Control Panel in the Windows taskbar, or use the key combination <code>Fn + F5</code> and F6 (see “Function/Hot Key Indicators” on page 1 - 14) to adjust.</td>
</tr>
<tr>
<td>The CD/DVD cannot be read.</td>
<td>The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.</td>
</tr>
<tr>
<td>The CD/DVD tray will not open when there is a disc in the tray.</td>
<td>The CD/DVD is not correctly placed in the tray. Gently try to remove the disc using the eject hole (see “Loading Discs” on page 2 - 3).</td>
</tr>
<tr>
<td>The DVD regional codes can no longer be changed.</td>
<td>The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5/“DVD Regional Codes” on page D - 2.</td>
</tr>
<tr>
<td>Unwelcome numbers appear when typing.</td>
<td>If the LED ( \text{ is lit, then Num Lock is turned ON.} ) (see “LED Indicators” on page 1 - 11).</td>
</tr>
</tbody>
</table>
# Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The system freezes</strong> or the screen goes dark.</td>
<td><em>The system’s power saving features have timed-out.</em> Use the AC/DC adapter, press the sleep (Fn + F4) key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td><strong>The system never goes into a power saving mode.</strong></td>
<td><em>Power Options features are not enabled.</em> Go to the Windows Power Options menu and enable the features you prefer (see “Power-Saving States” on page 3 - 6/”System Power Options” on page D - 20). Make sure you have enabled Hibernate mode from the control panel.</td>
</tr>
<tr>
<td><strong>The Wireless LAN/Bluetooth/3.5G modules cannot be detected.</strong></td>
<td><em>The modules are off.</em> Check the LED indicator and/or function key indicator to see if the WLAN/Bluetooth/3.5G module is on or off (see “LED Indicators” on page 1 - 11). If the LED indicator is off, then press the Fn + F11 (WLAN), Fn + F12 (Bluetooth) or Fn + (3.5G) key combination(s) in order to enable the modules (see “Function/Hot Key Indicators” on page 1 - 14).</td>
</tr>
</tbody>
</table>

---

**Other Keyboards**

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However, special functions/hot keys unique to the system’s regular keyboard may not work.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>PC Camera</strong> module cannot be detected.</td>
<td><em>The module is off</em>. Press the <strong>Fn + F10</strong> key combination in order to enable the module (see “<strong>Function/Hot Key Indicators</strong>” on page 1 - 14). Run the <strong>BisonCap</strong> program to view the camera picture.</td>
</tr>
<tr>
<td>The <strong>Wireless LAN/Bluetooth/PC Camera/3.5G</strong> modules cannot be configured.</td>
<td>The driver(s) for the module(s) have not been installed. Make sure you have installed the driver for the appropriate module (see the instructions for the appropriate module in “<strong>Modules &amp; Options</strong>” on page 7 - 1/“<strong>Module Drivers</strong>” on page D - 31).</td>
</tr>
<tr>
<td>A file cannot be copied to/from a connected <strong>Bluetooth</strong> device.</td>
<td><em>The transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported)</em>. If you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.</td>
</tr>
<tr>
<td>The <strong>Bluetooth</strong> module is off after resuming from Sleep.</td>
<td><em>The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state</em>. Use the key combination (<strong>Fn + F12</strong>) to power on the Bluetooth module after the computer resumes from Sleep.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Hibernate function has disappeared.</td>
<td>You have a computer with 4GB of RAM and have installed Windows Vista Service Pack 1. This is a known issue if your computer has 4GB of RAM and is running Windows Vista Service Pack 1. To re-enable Hibernate mode go to the Command Prompt and type the command “powercfg -h on” (make sure you are logged on as an Administrator):</td>
</tr>
</tbody>
</table>
|                                                                         | 1. Click Start (menu button).  
2. Type “cmd” in the Start Search box.  
3. Double click the Command Prompt when it appears in the menu.  
4. Type “powercfg -h on” in the Command Prompt window.  
5. Close the Command Prompt window.  
6. The Hibernate function will now be enabled. |
Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
## Notebook Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Reader Port</td>
<td>The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device.</td>
</tr>
<tr>
<td>MMC / SD / MS</td>
<td></td>
</tr>
<tr>
<td>DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td>External Monitor (VGA) Port</td>
<td>This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or simultaneous display on the LCD and external monitor/FPD.</td>
</tr>
<tr>
<td>Headphone-Out Jack</td>
<td>Headphones or speakers may be connected through this jack. <strong>Note</strong>: Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td>Microphone-In Jack</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
<tr>
<td>RJ-11 Modem Jack</td>
<td>This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11 telephone connection. <strong>Note</strong>: Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
</tbody>
</table>
# Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| RJ-45 LAN Jack           | This port supports LAN (Network) functions.  
|                          | **Note:** Broadband (e.g. ADSL) modems usually connect to the LAN port.    |
| Security Lock Slot       | To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.    |
| S/PDIF-Out Jack          | This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound. |
| USB 2.0/1.1 Ports        | These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device). |
Appendix B: Intel Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 20.

Intel Video Driver Installation

Make sure you install all the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Video

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click 2. Install Video Driver > Yes.
3. Click Next > Yes > Next > Next.
4. Click Finish to restart the computer.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically allocates as much (up to 256MB) system memory (RAM) as needed to the video system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the operating system.

DVMT Notes

DVMT is not local video memory.
DVMT is not user-configurable.
DVMT will not function in MS-DOS. DOS uses the legacy memory indicated.
Intel Video Driver Controls

Intel Graphics Properties

More advanced video configuration options are provided by the Intel(R) Graphics Media Accelerator Driver for mobile control panel.

1. Open the Display Settings control panel (see “Video Features” on page 1-20) and click Advanced Settings (button).
2. Click the Intel(R)... tab and click Graphics Properties (button).

Taskbar Icon

The Intel GMA control panel can also be accessed by clicking the icon in the taskbar and selecting Graphics Properties from the menu.

If you cannot see the tray icon click the “Show Tray Icon” tickbox in the Intel(R) Graphics Media Accelerator for Mobile tab.

Figure B - 1

Intel Graphics Properties

B - 2 Intel Graphics Properties
You may make changes to the devices, color, schemes, **Hot Keys** etc. by clicking the appropriate menu item or button.

**Help Menus**
Right-click on many of the items in the tabs to bring up the “**What’s This?**” button.

Click the “**What’s This?**” button to bring up the help menu.

**Display Selection**
At least one other display must be attached in order to view multiple **Display Selection** options.

**Figure B - 2**
**Intel Graphics Media Accelerator Driver for mobile**
(Control Panel Tabs)
Scheme Options
Use Scheme Options to configure quick settings for applications which require specific resolution and color settings in order to run properly e.g. games, multimedia programs. To set the scheme options:

1. Open the Display Settings control panel and click Advanced Settings (button).
2. Click the Intel(R)... tab and click Graphics Properties (button).
3. Configure your display configuration, resolution etc. as per your requirements from Display Settings.
4. Click on Scheme Options (button).
5. Type a name for the scheme then click Save.
6. If you want to automatically launch an application when the scheme is applied, click the tickbox ("Automatically launch an application when the scheme is applied") and then click on Browse (button).
7. Browse to the executable file for the application you want to set the scheme for (see sidebar), and click Open to select it.
8. Click Save (Save > OK) to save the settings (you can click in the "Restore the display settings after exiting this application" box to return to your original settings when you exit the program).
9. Click OK to exit the window.
10. Click the taskbar icon and Select Scheme to run the scheme.

Application.exe
You will need to locate the actual application executable (.exe) file, not just the shortcut. To find the application right-click its shortcut on the desktop click Properties. Click the Shortcut (tab) and see where the executable file is located by clicking the Find Target (button). Note the location and you will then be able to browse to this file.

Figure B - 3
Select Scheme
Attaching Other Displays

Besides the built-in LCD you can also use an external monitor/flat panel display, connected to the external monitor port on the left of the computer, as your display device. The following are the display options:

1. The built-in LCD OR an external monitor/flat panel display connected to the external monitor port (Single Display).
2. The built-in LCD AND an external monitor/flat panel display connected to the external monitor port (Multiple Display).

Configuring Other Displays from Windows Vista

1. Attach your external display to the external monitor port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the Windows Mobility Center control panel (Mobile PC > Adjust commonly used mobility settings) and click Connect display.
3. Click on any of the buttons to configure the displays to your preference, or click Display Settings to access the control panel.

Function Key Combination

You can use the Fn + F7 key combination to toggle through the display options:

- Notebook Only
- External Display Only
- Notebook + External Display

Make sure you give the displays enough time to refresh.

Figure B - 4
Windows Mobility Center & New Display Detected
**Configuring Other Displays from Intel® GMA Driver for Mobile**

1. Go to the Intel(R) GMA Driver for mobile control panel (see “Intel Graphics Properties” on page B - 2) and click Display Devices.
2. Click to choose the display mode from the Operating Mode menu.
3. Choose which device is to be the Primary Device/Secondary Device from the Display Selection menu.
4. Click Apply (and OK to confirm the settings change) and OK (button).

**Display Selection**
At least one other display must be attached in order to view multiple Display Selection options.

**BIOS Setting**
Make sure that you have not disabled external display detection in the BIOS if attempting to connect external displays (see “Advanced Chipset Control (Advanced Menu)” on page 5 - 8).

*Figure B - 5 Display Devices*
Display Modes

**Single Display**
Only one of your attached displays is used.

**Intel(R) Dual Display Clone (mirrored)**
This mode will drive multiple displays with the same content. Each device may be configured independently for different resolutions, refresh rates, color quality etc. Use this feature to display the screen through a projector for a presentation.

**Extended Desktop (extended)**
This mode allows a desktop to span multiple displays and acts as a large workspace. This creates a lot more screen area for display. Use the **Display Properties** control panel to drag the monitors to match the physical arrangement you wish to use, or you may also use the **Extended Desktop Settings** control panel tab in **Graphics Properties** to configure the relative size and position.
To Enable Intel(R) Dual Display Clone
1. Attach your external monitor to the external monitor port, and turn it on.
2. Go to the Intel(R) GMA Driver for mobile control panel (see “Intel Graphics Properties” on page B - 2) and click Display Devices.
3. Click to choose Intel(R) Dual Display Clone (Operating Mode).
4. Choose which device is to be the Primary Device/Secondary Device from the Display Selection menu.
5. Click Apply, and OK to confirm the settings change.
6. Click Display Settings to adjust the settings for the attached devices.

Figure B - 6
Display Devices & Settings
To Enable Extended Desktop

1. Attach your external monitor to the external monitor port, and turn it on.
2. Go to the Intel(R) GMA Driver for mobile control panel (see “Intel Graphics Properties” on page B - 2) and click Display Devices.
3. Click to choose Extended Desktop (Operating Mode).
4. Choose which device is to be the Primary Device/Secondary Device from the Display Selection menu.
5. Click Apply, and OK to confirm the settings change.
6. Click Display Settings to adjust the settings for the attached devices.

Click the appropriate monitor icon and drag it to match the physical arrangement you wish to use (e.g. the secondary display may be extended left/right/above/below the primary display).

Click Display Settings to make any adjustments required.

Display Settings

Extended Desktop

You can have different Color Quality, Screen Resolution and Refresh Rate settings for each display device provided your device can support them.

You can drag the monitor icons to match the physical layout of your displays. Icons and programs may also be dragged between the displays.

Figure B - 7

Extended Desktop Mode
Using Windows Vista to Enable Extended Mode

1. Attach your external display to the external monitor port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the Windows Mobility Center control panel (Mobile PC > Adjust commonly used mobility settings) and click Connect display.
3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

Display Settings Extended Desktop

Use the control panel to drag the monitors to match the physical arrangement you wish to use.

You can drag any icons or windows across to either display desktop, which makes it possible to have one program visible in one of the displays, and a different program visible in the other display.

Figure B - 8
Display Properties (Extended Desktop)
Using Display Settings to Enable Extended Mode

1. Attach your external display to the external monitor port, and turn it on.
2. Open the **Display Settings** control panel (see “**Video Features**” on page 1 - 20).
3. Click the monitor icon (e.g. 2), and make sure you have checked “**Extend my Windows desktop onto this monitor**.” and click **Apply**.

Click the appropriate monitor icon (e.g. 2) to be able to select the option to extend the desktop on to it.

In this example the Primary Display 1 is on the left, the Secondary Display 2 is on the right.

*Figure B - 9
Display Properties
(Extended Desktop)*
# Appendix C: Specifications

## Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed, delayed or updated due to the manufacturer's release schedule. Check with your service center for details.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Intel® Core™2 Duo Processor 35W - (478-pin) Micro-FC-PGA Package - Socket-P T9400/ T9600</td>
</tr>
<tr>
<td></td>
<td>Intel® Core™2 Duo Processor 25W - (478-pin) Micro-FC-PGA Package - Socket-P P9500</td>
</tr>
<tr>
<td></td>
<td>Intel® Core™2 Duo Processor 25W - (478-pin) Micro-FC-PGA Package - Socket-P P8400/ P8600</td>
</tr>
<tr>
<td>Core Logic</td>
<td>Intel GM45 + ICH9M Chipset</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LCD</strong></td>
<td><strong>Model A:</strong> 12.1&quot; WXGA (1280 * 800) TFT LCD</td>
</tr>
<tr>
<td></td>
<td><strong>Model B:</strong> 13.3&quot; WXGA (1280 * 800) TFT LCD</td>
</tr>
<tr>
<td></td>
<td>Optional: LCD with LED Backlight</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>64-bit Wide DDRII (DDR2) Data Channel</td>
</tr>
<tr>
<td></td>
<td>Supports Dual Channel DDRII (DDR2) SDRAM</td>
</tr>
<tr>
<td></td>
<td>Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) 667MHz/800MHz RAM Modules</td>
</tr>
<tr>
<td></td>
<td>Memory Expandable up to 4GB (1024/2048 MB DDR2 Modules)</td>
</tr>
<tr>
<td></td>
<td>Intel Turbo Memory (Robson) NAND Flash 2G Memory Card Module (<em>Factory Option</em>)</td>
</tr>
<tr>
<td><strong>Video Adapter</strong></td>
<td>Intel GM45 Integrated Video</td>
</tr>
<tr>
<td></td>
<td>High Preference 3D/2D Graphic Accelerator</td>
</tr>
<tr>
<td></td>
<td>Supports Dynamic Video Memory Technology DVMT (up to 256MB dynamically allocated from system memory where needed)</td>
</tr>
<tr>
<td></td>
<td>Supports DirectX10 3D Graphics Engine Accelerator</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>Security (Kensington® Type) Lock Slot</td>
</tr>
<tr>
<td></td>
<td>Fingerprint ID Reader Module (<em>Factory Option</em>)</td>
</tr>
<tr>
<td><strong>BIOS</strong></td>
<td>One 32Mb SPI Flash ROM</td>
</tr>
<tr>
<td></td>
<td>Phoenix™ BIOS</td>
</tr>
<tr>
<td><strong>Storage</strong></td>
<td>One Changeable 12.7mm(h) SATA (Serial) Optical Device (CD/DVD) Type Drive</td>
</tr>
<tr>
<td></td>
<td>Easy Changeable 2.5&quot; 9.5 mm (h) SATA (Serial) HDD</td>
</tr>
</tbody>
</table>

---

C - 2 Specifications
# Specifications

## Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Audio</strong></td>
<td>High Definition Audio (HDA)</td>
</tr>
<tr>
<td></td>
<td>Compliant with Microsoft UAA (Universal Audio Architecture)</td>
</tr>
<tr>
<td></td>
<td>Direct Sound 3D™ Compatible</td>
</tr>
<tr>
<td></td>
<td>2 * Built-In Speakers</td>
</tr>
<tr>
<td></td>
<td>Built-In Microphone</td>
</tr>
<tr>
<td><strong>Keyboard &amp; Pointing Device</strong></td>
<td>Winkey Keyboard</td>
</tr>
<tr>
<td></td>
<td>Built-In TouchPad with Scrolling Function</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>Three USB 2.0 Ports</td>
</tr>
<tr>
<td></td>
<td>One Headphone-Out Jack</td>
</tr>
<tr>
<td></td>
<td>One Microphone-In Jack</td>
</tr>
<tr>
<td></td>
<td>One S/PDIF Out Jack</td>
</tr>
<tr>
<td></td>
<td>One Internal Microphone</td>
</tr>
<tr>
<td></td>
<td>One RJ-11 Modem Jack</td>
</tr>
<tr>
<td></td>
<td>One RJ-45 LAN Jack</td>
</tr>
<tr>
<td></td>
<td>One DC-In Jack</td>
</tr>
<tr>
<td></td>
<td>One External Monitor Port</td>
</tr>
<tr>
<td><strong>Card Reader</strong></td>
<td>Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)</td>
</tr>
<tr>
<td></td>
<td>Note: MS Duo/Mini SD/ RS MMC Cards require a PC adapter</td>
</tr>
<tr>
<td><strong>ExpressCard Slot</strong></td>
<td>One ExpressCard/34(54) Slot</td>
</tr>
<tr>
<td><strong>Mini-Card Slots</strong></td>
<td>One Mini-Card Slot for Wireless LAN Module</td>
</tr>
<tr>
<td></td>
<td>One Mini-Card Slot for 3.5G Module OR Turbo Memory Module</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication</strong></td>
<td>10M/ 100/ 1000Mb Base-TX Ethernet LAN</td>
</tr>
<tr>
<td></td>
<td>Azalia 56K Modem V.90 &amp; V.92 Compliant</td>
</tr>
<tr>
<td><strong>Wireless LAN Modules:</strong></td>
<td>Intel® WiFi Link 5300 Series (3*3 - 802.11a/g/n) Wireless LAN Mini-Card Module (Option - not available for Model B computers with LED backlight)</td>
</tr>
<tr>
<td></td>
<td>Intel® WiFi Link 5100 Series (1*2 - 802.11a/g/n) Wireless LAN Mini-Card Module (Option)</td>
</tr>
<tr>
<td></td>
<td>3rd Party 802.11b/g Wireless LAN Mini-Card Module with USB interface (Option)</td>
</tr>
<tr>
<td></td>
<td>Bluetooth 2.0 + EDR (Enhanced Data Rate) Module (Factory Option)</td>
</tr>
<tr>
<td></td>
<td>1.3M or 2.0M Pixel PC Camera Module with USB interface (Factory Option)</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>2.0M Pixel PC Camera Module Option is not available for Model B computers with LED backlight</td>
</tr>
</tbody>
</table>

**3.5G Module** (see sidebar and page A - 6):  
UMTS/HSPDA-based 3.5G Mini-Card Module with USB Interface (Factory Option)  
Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)  
UMTS WCDMA FDD (2100 MHz)

---

**UMTS Modes**  
Note that UMTS modes CAN NOT be used in North America.
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Management</strong></td>
<td>Supports ACPI 3.0 Supports Wake on LAN Supports Resume from Modem Ring</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>Full Range AC/DC Adapter AC Input 100 - 240V, DC Output 50 - 60Hz, 19V, 3.42A or 18.5V, 3.5A (65 Watts)</td>
</tr>
<tr>
<td><strong>Battery</strong></td>
<td>4 Cell Smart Lithium-Ion Battery Pack, 14.8V/2.4AH 8 Cell Smart Lithium-Ion Battery Pack, 14.8V/4.4AH (Option)</td>
</tr>
</tbody>
</table>
| **Environmental Spec**   | Temperature  
Operating: 5°C - 35°C  
Non-Operating: -20°C - 60°C  
Relative Humidity Operating: 20% - 80%  
Non-Operating: 10% - 90% |
| **Dimensions & Weight**  | **Model A:** 299mm (w) * 219mm (d) * 26.5-35.7mm (h) 1.88 kg With 4 Cell Battery and ODD  
**Model B:** 310mm (w) * 233mm (d) * 30-36mm (h) 2.0 kg With 4 Cell Battery and ODD  
**Model B - Optional LCD with LED Backlight:** 310mm (w) * 233mm (d) * 20-36mm (h) 2.0 kg With 4 Cell Battery and ODD |
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
</table>
| Optional | **Optical Drive Module Options:**  
SATA DVD/CD-RW Combo Drive Module  
SATA DVD Dual (Super Multi) Drive Module  
Intel® WiFi Link 5300 Series (3*3 - 802.11a/g/n)  
Wireless LAN Mini-Card Module (not available for Model B computers with LED backlight)  
Intel® WiFi Link 5100 Series (1*2 - 802.11a/g/n)  
Wireless LAN Mini-Card Module  
3rd Party 802.11b/g Wireless LAN Mini-Card Module with USB interface  
8 Cell Smart Lithium-Ion Battery Pack  
1.3M or 2.0M Pixel USB PC Camera Module (Factory Option)  
Note: (2.0M Pixel USB PC Camera Module is not available for Model B computers with LED backlight)  
Bluetooth 2.0 + EDR (Enhanced Data Rate) Module (Factory Option) | Intel Turbo Memory (Robson) NAND Flash 2G Memory Card Module (Factory Option)  
Fingerprint ID Reader Module (Factory Option)  
UMTS/HSPDA-based 3.5G Module with Mini Card Interface (Factory Option)  
Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)  
UMTS WCDMA FDD (2100 MHz) |

**UMTS Modes**  
Note that UMTS modes CAN NOT be used in North America.
Appendix D: Windows XP Information

This Appendix contains information (including control panel information, driver installation etc.) for users of the *Windows XP OS*. 
DVD Regional Codes

Changing DVD Regional Codes

Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

Table D - 1 - DVD Regional Codes
Windows XP Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all controls it may be necessary to toggle off Category View.
TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse.

Once you have installed the TouchPad driver (see “TouchPad” on page D - 30) you can configure the functions by double-clicking the TouchPad driver icon on the taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences. You will find further information at www.synaptics.com.
Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the basic function key combinations; visual indicators are available when the hot key utility is installed (see “Hot Key” on page D - 30). When the driver is installed, an icon will appear in the taskbar.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + ~</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>Fn + F7</td>
<td>Display Toggle</td>
</tr>
<tr>
<td>Fn + ✱</td>
<td>3.5G Module Power Toggle</td>
<td>Fn + F8/F9</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>Fn + F1</td>
<td>TouchPad Toggle</td>
<td>Fn + F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>Fn + F2</td>
<td>Turn LCD Backlight Off (Press a key or use TouchPad to turn on)</td>
<td>Fn + F11</td>
<td>WLAN Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
<td>Fn + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
<td></td>
<td>*Silent Mode Toggle</td>
</tr>
<tr>
<td>Fn + F5/F6</td>
<td>Volume Decrease/Increase</td>
<td></td>
<td>*Silent Mode will reduce fan noise and save power consumption. Note this may reduce computer performance.</td>
</tr>
</tbody>
</table>

Table D - 2 - Function & Hot Key Indicators
Audio Features

You can configure the audio options on your computer from the Sounds and Audio Devices \*\*Windows control panel, or from the Realtek HD Audio Manager icon in the taskbar/control panel (this will bring up the Realtek Audio Configuration menus). The volume may also be adjusted by means of the \*Fn + F5/F6 key combination.

**Sound Volume Adjustment**

How high the sound volume can be set depends on the setting of the volume control within \*Windows (and the volume control function keys on the computer). Click the Volume icon on the taskbar to check the setting.

*Figure D - 3 - Realtek Audio Configuration Menus*
Video Features

You can switch display devices, and configure display options, from the Display Properties control panel in Windows as long as the appropriate video driver is installed.

To access Display Properties in Windows:
1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen resolution (Figure D - 4 on page D - 8).
5. Click the arrow, and scroll to the preferred setting in Color quality (Figure D - 4 on page D - 8).
6. You can also access Display Properties by right-clicking the desktop and scrolling down and clicking Properties. Click Settings (tab) and adjust as above.
7. Open the Display Properties control panel, and click Advanced (button) (Figure D - 4 on page D - 8) to bring up the Advanced properties tabs.
8. Click the Intel(R) Graphics Media Accelerator Driver for Mobile tab, and click Graphics Properties (button) to make any video adjustments you require.
9. You can also access Graphics Properties from the Windows Intel(R) GMA Driver for Mobile control panel, or from the taskbar icon.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically allocates as much (up to 256MB) system memory (RAM) as needed to the video system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the operating system.
Windows XP Information

Display & Graphics Properties

Taskbar Icon
You can also access the controller properties from the taskbar. Click on the icon to bring up the menu and scroll to Graphics Properties.

If you cannot see the tray icon go to the Intel(R) Graphics Media Accelerator Driver for Mobile tab and click the "Show Tray Icon" tickbox. Alternatively right-click the desktop and select Graphics Options > Tray Icon > Enable.

Figure D - 4 - Display & Graphics Properties
You may make changes to the devices, color, schemes, **Hot Keys** etc. by clicking the appropriate menu item or button.

**Function Key Combination**

You can use the **Fn + F7** key combination to toggle through the display options:
- Notebook Only
- External Display Only
- Notebook + External Display

Make sure you give the displays enough time to refresh.

**Help Menus**

Right-click on many of the items in the tabs to bring up the **“What’s This?”** button.

Click the **“What's This?”** button to bring up the help menu.

**Figure D - 5 - Intel GMA Driver for Mobile**
Windows XP Information

Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT) or external Flat Panel Display as your display device. A VGA monitor/Flat Panel Display connects to the external monitor port. The following display modes are available.

<table>
<thead>
<tr>
<th>Intel Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Display</td>
<td>One of the connected displays is used as the display device</td>
</tr>
<tr>
<td>Multiple Display - Intel(R) Dual Display Clone</td>
<td>Both connected displays output the same view and may be configured independently</td>
</tr>
<tr>
<td>Multiple Display - Extended Desktop</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

*Figure D - 6 - Display Options*
Attaching Other Displays

If you prefer to use a monitor or flat panel display, connect it to the external monitor port on the left of the computer.

1. Attach your external display to the external monitor port, and turn it on.
2. Go to the Intel(R) GMA Driver for mobile control panel and click Display Devices.
3. Click to choose the display option from the Operating Mode menu.
4. Click Apply, and OK to confirm the settings change.

Display Selection

At least one other display must be attached in order to view multiple Display Selection options.

BIOS Setting

Make sure that you have not disabled external display detection in the BIOS if attempting to connect external displays (see “Advanced Chipset Control (Advanced Menu)” on page 5 - 8).

Figure D - 7
Display Devices
To Enable Intel(R) Dual Display Clone (Intel GMA)
1. Attach your external display to the external monitor port, and turn it on.
2. Go to the Intel(R) GMA Driver for mobile control panel and click Display Devices.
3. Click to choose Intel(R) Dual Display Clone (Operating Mode).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

*Figure D - 8 - Display Devices - Intel(R) Dual Display Clone*
To Enable Extended Desktop (Intel GMA)

1. Attach your external display to the external monitor port, and turn it on.
2. Go to the Intel(R) GMA Driver for mobile control panel and click Display Devices.
3. Click to choose Extended Desktop (Operating Mode).
4. Click Apply, and OK to confirm the settings change.
5. Click Display Settings to adjust the settings for the attached devices.

Click the appropriate monitor icon and drag it to match the physical arrangement you wish to use (e.g. the Secondary Device may be extended left/right/above/below the Primary Device).

Click Display Settings to make any adjustments required.

Figure D - 9 - Display Devices - Extended Desktop
Windows XP Information

To Enable Extended Desktop (Windows Display Properties)
1. Attach your external monitor to the external monitor port, and turn it on.
2. Click Start, point to Settings (or click Control Panel) and click Control Panel (if you are in Category View choose Appearance and Themes).
3. Double-click Display (icon).
4. In the Display Properties dialog box, click Settings (tab).
5. Click the monitor icon (e.g. 2), and make sure you have checked “Extend my Windows desktop onto this monitor.” and click Apply.

Click the appropriate monitor icon (e.g. 2) to be able to select the option to extend the desktop on to it.

In this example the Primary Display 1 is on the left, the Secondary Display 2 is on the right.

![Display Properties (Extended Desktop)](image)

Figure D - 10 - Display Properties (Extended Desktop)

D - 14 Attaching Other Displays
Power Management Features

To conserve power, especially when using the battery, your computer uses the ACPI power management system. Power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system.

The Power Options control panel icon in Windows (see page D - 3) allows you to configure power management features for your computer. You may conserve power through individual components such as the monitor or hard disk, or you may use either Stand by or Hibernate mode to conserve power throughout the system.

Advanced Configuration and Power Interface

The ACPI interface provides the computer with enhanced power saving techniques and gives the operating system (OS) direct control over the power and thermal states of devices and processors. For example, it enables the OS to set devices into low-power states based on user settings and information from applications. ACPI is fully supported in Windows XP.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user's manual of your operating system.

(Note: All pictures used on the following pages are from the Windows XP OS.)
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page D - 26).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page D - 23.
Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options in the Windows control panel to configure this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button as Stand by or Hibernate Button

If you are using a fully ACPI-compliant OS, (such as Windows XP) you can use the OS’s “Power Options” control panel to set the power button to send the system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring the Power Button” on page D - 22 for details).

Shutdown

Note that you should always shut your computer down by choosing the Turn Off Computer command from the Start menu in Windows. This will help prevent hard disk or system problems.
Power Schemes

You can set your computer to conserve power through individual components by means of **Power Schemes**. You can also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the computer's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or writes data, the hard disk motor will be turned back on). The schemes may also be set to set a specified time for the system to enter Stand by or Hibernate modes (see “System Power Options” on page D - 20).

**Resuming Operation**

Press a key on the keyboard, or move the mouse/TouchPad to resume from Monitor or Hard Disk Stand by.
Each *Windows Power Scheme* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose the *Home/Office Desk* scheme for maximum performance when the computer is powered from an AC power source. Choose the *Max Battery* scheme (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered. *Windows* will use *Portable/Laptop* as the default scheme.
System Power Options

You can use the system power options to stop the computer’s operation and restart where you left off. This system features Stand by and Hibernate sleep mode levels (Hibernate mode will need to be enabled by clicking the option in the Hibernate tab in the Power Options control panel - see “Hibernate” on page D - 21).

Hibernate Mode vs. Shutdown

Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

You can use either method depending on your needs.

Stand by Mode vs. Hibernate Mode

If you want to stay away from your work for just a while, you can put the system on Stand by instead of in hibernation. It takes a longer time to wake up the system from Hibernate mode than from Stand by mode.
Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full operation. During Stand by the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Stand by mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You can set your computer to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power button.

System Resume
The system can resume from Stand by mode by:
- Pressing the power button
- Pressing the Sleep/Resume key combination
- An incoming call received on the modem (if enabled)
- Network card (Wake On LAN) activity (if enabled)

Figure D - 12
Enable Hibernation
Configuring the Power Button

The power button may be set to send the computer into either **Stand by** or **Hibernate** mode. In **Stand by** mode, the LED will blink green. In **Hibernate** mode, the LED will be off (battery) or orange (AC/DC adapter). If you are in a power saving mode set to save power through individual components (e.g. hard disk, monitor), the LED will remain green.

Sleep Button

You may also configure the **Sleep/Resume** key combination (Fn + F4) from the menu illustrated. In Windows this is referred to as the **Sleep** button.

*Figure D - 13*
**Power Options**
(Advanced - Power Buttons)
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page D - 26 for instructions on how to do this).

Battery Life
Your computer’s battery life is dependent upon many factors, including the programs you are running, and peripheral devices attached. Power Options (you may set low battery Alarms and actions, and check the Power Meter from the Power Options control panel), and settings in the OS will help prolong the battery life if configured appropriately.

Figure D - 14
Power Options (Alarm & Power Meter)
Windows XP Information

Battery life may be shortened through improper maintenance. **To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.**

We recommend that you do not remove the battery yourself. If you need to remove the battery for any reason, see **“Removing the Battery” on page 6 - 3.**

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to **“LED Indicators” on page 1 - 11** for information on the battery charge status, and to **“Battery Information” on page D - 23** for more information on how to maintain and properly recharge the battery pack.)

Conserving Battery Power

To conserve battery power:

- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
- Close modem or communication applications when they are not being used.
- Remove any unused PC Cards from the computer (PC Cards quickly use up battery power even if the system enters sleep mode).
- Disconnect any unnecessary external devices.

D - 24 Battery Information
Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning
Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by yourself even when you see a message that indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own. Disable the **Power Options** functions in the **Control Panel**, especially any **Alarms** (unclick the tickboxes - see page *D - 23*) and **Schemes** (change all the settings to **Never** - see page *D - 18*). As the battery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Driver Installation

Insert the Device Drivers & Utilities + User’s Manual CD-ROM, click Install Drivers/Option Drivers (button) and then click the appropriate driver name from the Drivers Installer menu. Follow the instructions to install the driver. Alternatively click Start, navigate (Browse..) to the executable file and then follow the manual setup instructions.

1. Check the driver installation order from Table 5 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, after installing each driver it will become greyed out (if you need to reinstall any driver, click the Unlock button).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.
### Windows XP Information

<table>
<thead>
<tr>
<th>WinXP SP2 Driver</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>Page D - 29</td>
</tr>
<tr>
<td>Video</td>
<td>Page D - 29</td>
</tr>
<tr>
<td>Audio</td>
<td>Page D - 29</td>
</tr>
<tr>
<td>Modem</td>
<td>Page D - 30</td>
</tr>
<tr>
<td>LAN</td>
<td>Page D - 30</td>
</tr>
<tr>
<td>TouchPad</td>
<td>Page D - 30</td>
</tr>
<tr>
<td>CardReader</td>
<td>Page D - 30</td>
</tr>
<tr>
<td>Hot Key</td>
<td>Page D - 30</td>
</tr>
<tr>
<td>Wireless LAN Module</td>
<td>Page D - 37</td>
</tr>
<tr>
<td>PC Camera Module</td>
<td>Page D - 41</td>
</tr>
<tr>
<td>3.5G Module</td>
<td>Page D - 48</td>
</tr>
<tr>
<td>Fingerprint Reader Module</td>
<td>Page D - 49</td>
</tr>
</tbody>
</table>

**Table 5 - Driver Installation**

#### Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the *Windows OS* and double-click the *Add/Remove Programs* item. **If you see the individual driver listed** (if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

If the driver is not listed in the *Add/Remove Programs* item:

1. Click **Start** (menu), point to **Settings** and click **Control Panel** (or click **Start > Control Panel**).
2. Double-click **System** (icon); **System** (icon) is in **Performance and Maintenance** (category).
3. Click **Hardware** (tab) > **Device Manager** (button).
4. Double-click the **device** you wish to update/reinstall the driver for (you may need to click "+").
5. Look for the **Update Driver** button (check the **Driver** tab) and follow the on screen prompts.
Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual disc, click Install Drivers/Option Drivers (button) and then click the appropriate driver name from the Drivers Installer menu.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Audio
1. Click 3.Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Windows XP Service Pack 2
Make sure you install Windows XP Service Pack 2 (or a Windows XP version which includes Service Pack 2) before installing any drivers. Service Pack 2 includes support for USB 2.0.

If you have upgraded the system by installing Service Pack 2 (i.e. your Windows XP version does not include Service Pack 2) then follow these instructions:
1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click the Hardware (tab) > Device Manager (button).
4. Click “+” next to Other Devices (if its sub-items are not shown).
5. Right-click Universal Serial Bus (USB) Controller and select Uninstall > OK (if you don’t see the item then there is no need to take any further action).
6. Restart the computer and it will find the USB 2.0 controller.
Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.

---

Modem Country Selection

Be sure to check if the modem country selection is appropriate for you (Control Panel > Phone and Modem Options).

LAN
1. Click 5.Install LAN Driver > Yes.
2. Click Next.
3. Click Install > Finish.
4. The network settings can now be configured.

TouchPad
1. Click 6.Install Touchpad Driver > Yes.
2. Click Next > Next > Next.
3. Click Finish to restart the computer.

CardReader
1. Click 7.Install CardReader Driver > Yes.
2. Click Next > Install.
3. Click Finish.

Hot Key
1. Click 8.Install Hotkey Utility > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.
Module Drivers
See the following pages for the driver installation procedures for any of the optional modules included in your purchase configuration.

Bluetooth Module
Note: The operating system is the default setting for Bluetooth control in Windows XP, and does not require a driver. See “Bluetooth Module” on page D - 32 for configuration instructions.

Wireless LAN Module
See the introduction in “Wireless LAN Module” on page D - 37, and check the installation procedure.

PC Camera Module
See the introduction in “PC Camera Module” on page D - 41, and check the installation procedure.

3.5G Module
See the introduction in “3.5G Module” on page D - 48, and check the installation procedure.

Fingerprint Reader Module
See the introduction in “Fingerprint Reader Module” on page D - 49, and check the installation procedure.
Windows XP Information

Wireless LAN, Bluetooth & 3.5G Modules

Bluetooth Module

The operating system’s Bluetooth Devices control panel is used to configure the Bluetooth settings in Windows XP, and therefore does not require a driver. Use the Fn + F12 key combination (see “Function/Hot Key Indicators” on page D - 5) to toggle power to the Bluetooth module.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Wireless LAN, Bluetooth & 3.5G Modules Power Toggle

Enable power to the modules as follows:
Fn + F11 = Wireless LAN Module Power Toggle
Fn + F12 = Bluetooth Module Power Toggle
Fn +  = 3.5G Module Power Toggle

The LED indicator will be green if the WLAN module is on, and orange if the Bluetooth module is on. The LED indicator will be green if the 3.5G module is on.

Bluetooth Data Transfer

Note that transferring data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported).

Therefore if you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.
Bluetooth Local Area Connection Icon

If you want to display the Local Area Connection icon for the Bluetooth connection in the taskbar, set it up as follows:

1. Access the **Network Connections** control panel in **Windows** (Start > Settings > Network Connections OR Start > Connect To > Show all Connections) or by clicking the taskbar icon.
2. Right-click the Bluetooth connection icon, and select **Properties**.
3. Click to put a tick (if none is present) in the “Show icon in the notification area when connected” box and click **OK**.
4. Close the control panels and the icon for the Bluetooth local area connection will be displayed in the taskbar when connected (see sidebar and overleaf).

---

**Wireless Device Operation Aboard Aircraft**

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the **Fn + F12** key combination button to toggle power to the Bluetooth module, and check the LED indicator to see if the module is powered on or not (see **Table D - 2**, on page D - 5 **Table 1 - 3**, on page 1 - 11).

---

**Figure D - 18**

Local Area Connection
Windows XP Information

Bluetooth Configuration in Windows XP

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module.
2. A Bluetooth icon  will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control panel.
   - Double-click the icon  to access the Bluetooth Devices control panel.
   - Click Start, and click Control Panel (or point to Settings and click Control Panel), and then click Bluetooth Devices (Network and Internet Connections).
   - Click/Right-click the icon  and choose an option from the menu.

Note that you will need to check the LED indicator to see if the module is powered on or not.

Figure D - 19
Bluetooth Devices & Click Icon Menu
To Add a Bluetooth Device

1. Access the Bluetooth Devices control panel.
2. Click **Options** (tab), and make sure that **Allow Bluetooth devices to connect to this computer** check box (Connections) has a tick inside it.
3. Click **Devices** (tab), and then click **Add**.
4. The **Add Bluetooth Device Wizard** will appear.
5. Click to select **“My device is set up and ready to be found”**, and then click **Next**.
6. The **Wizard** will then search for any available Bluetooth devices within range.
7. Click to select the device you want to communicate with, and click **Next**.
8. Select an appropriate passkey option and click **Next**.
9. Click **Finish**.
Windows XP Information

To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:
   • Change the name of the device (click General, type a new name and click OK).
   • Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Turn discovery on check box (Discovery) has a tick inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check box (Connections) has a tick inside it, if you want to be notified when a Bluetooth device wants to connect.

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use the key combination (Fn + F12) to power on the Bluetooth module after the computer resumes from Sleep.
Wireless LAN Module

If you have included an Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) WLAN or 3rd Party 802.11 b/g WLAN module in your purchase option, make sure that the Wireless LAN module is on before installing the driver.

Use the **Fn + F11 key combination** (see "Function/Hot Key Indicators" on page D - 5) to toggle power to the Wireless LAN module. Make sure you install the drivers in the order indicated in *Table 5, on page D - 28*.

**Note:** The Intel® Wi-Fi Link 5300 Series WLAN module is not available as an option for Model B computers with an LED Backlight LCD.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the Fn + F11 key combination button to toggle power to the WLAN module, and check the LED indicator to see if the module is powered on or not (see *Table D - 2, on page D - 5/ Table 1 - 3, on page 1 - 11*).

Download Prerequisite Files for Intel WLAN

Before beginning the Intel® Wi-Fi Link 5100/5300 Series driver installation process for *Windows XP* it is necessary to make sure you have a working internet connection. You will then be pointed to download the required Windows Installer 3.1 and Microsoft MSXML 6.0 files.
Intel WLAN Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next > Next to link to the required prerequisites on the internet.
5. Click Download (button) to download the Windows Installer executable (.exe) file to the computer’s hard disk.
6. Double-click (or click the Run button) to install the Windows Installer file and follow the on-screen instructions for file installation.
7. You will be required to restart the computer to complete the file installation.
8. Repeat steps 1 to 4 to get to the appropriate download location.
9. Click Download (button) to download the Microsoft MSXML file to the computer’s hard disk (if you are unsure of which file to download for you processor you can click Run instead of acknowledging the file, and you will be informed if the file is appropriate or not).
10. Follow the on-screen instructions for file installation.
11. After the files have been installed click Next > Next.
12. Click the button to accept the license and click Next > Next > Next.
13. Click Finish to complete the installation.
14. Configure the settings by going to the Intel PROSet Wireless WiFi Connection Utility (Start > Programs/All Programs > Intel PROSet Wireless WiFi Connection Utility), or by double-clicking the taskbar icon.
15. Click to select any available network, and click Connect to establish a connection.
16. If you do not see your Wireless Access Point click Refresh (button).
17. Click **Help** (link) to bring up the **Help** Menu.

18. Make sure that the **WiFi On** button is selected.
802.11b/g WLAN Driver Installation

1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.
7. The operating system is the default setting for Wireless LAN control in Windows XP.
8. Access any available wireless networks from Network Connections > Wireless Network Connection menu in Windows (or click the icon in the taskbar), and click View Wireless Connections.

Figure D - 24
Wireless Network Control Panels
PC Camera Module

The PC Camera module uses the BisonCap application to capture video files and to take pictures. Before installing the driver, make sure that the optional PC Camera is on.

Use the Fn + F10 key combination (see “Function/Hot Key Indicators” on page D - 5) to toggle power to the PC Camera module. Make sure you install the drivers in the order indicated in Table 5, on page D - 28.

Note: The 2.0M Pixel PC Camera module is not available as an option for Model B computers with an LED Backlight LCD.
Windows XP Information

PC Camera Driver Installation
1. Make sure the module is powered on, and then insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers** (button).
3. Click **2. Install Camera Driver > Yes**.
4. Choose the language you prefer and click **Next**.
5. Click **Next > Finish** to restart the computer.
6. Run the **BisonCap** application program from the **BisonCam** shortcut on the desktop, or from the **BisonCam** item in the **Start > Programs/All Programs** menu (if the hardware is turned off use the **Fn + F10** key combination to turn it on again).
PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
2. Click Advanced in the Volume > Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select Realtek HD Audio Input from the Mixer device menu.
5. Make sure the Mic Volume (check box) is checked, then click OK.
6. Boost the volume in the Recording section (in the Recording Control menu) as high as it will go.
7. Close the Recording Control window, and then click OK.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Realtek HD Audio Input (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
BisonCap

BisonCap is a video viewer for general purpose video viewing and testing, and for capturing video files to .avi format.

1. Run the BisonCap application from the Start > Programs/All Programs > BisonCam menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page D - 43) and select Start Capture.
3. Click OK (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to stop the capture (you can view the file using the Windows Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the "Capture file size:" and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page D - 45 in order to save file space, and help prevent system problems.
Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to My Computer, right-click the hard disk, and select Properties) If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows XP system requires a minimum of 1.5GB of free space on the C: drive system partition. In order to prevent system problems it is recommended that you save the captured video file to a location other than the C: drive (see “Set Capture File” on page D - 44), limit the file size of the captured video (see “Pre-Allocating File Space” on page D - 44) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:
1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
Eliminating Screen Flicker
If you find that the video screen in the BisonCap program is flickering, you can try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure D - 25
Video Capture Filter
Windows XP Information

Zoom
The BisonCap programs allows you to zoom the camera in and out.

1. Run the BisonCap program.
2. Go to Zoom and select Zoom Out/Zoom In.
3. Go to Options and scroll down to select Setting (Use the slider to adjust the zoom level, and click OK to save the setting).

Taking Still Pictures
The BisonCap program allows you to take still pictures.

1. Run the BisonCap program.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.
Windows XP Information

3.5G Module

If you have included an optional 3.5G module in your purchase option follow the instructions on page 7 - 20 to install the USIM card (which will be provided by your service provider), and then install the application.

Before installing the application, make sure that the 3.5G module is on. Use the Fn + key combination (see “Function/Hot Key Indicators” on page 1 - 14) to toggle power to the 3.5G module.

3G Watcher Application Installation

1. Enable power to the module by pressing the Fn + key combination (the icon will be green).
2. If a Found New Hardware Wizard appears, click Cancel.
4. Click Option Drivers (button).
5. Click 3.Install 3G Driver > Yes.
6. Click Next, click the button to accept the license agreement, and then click Install.
7. When the next screen appears wait about 2 minutes before clicking Finish (to allow the hardware to detect the 3.5G module).
8. The 3G Watcher icon will appear on the desktop.
9. You can access the 3G Watcher application from the Start menu (Start > Programs/All Programs > Sierra Wireless > 3G Watcher), or by clicking the desktop icon.
10. Make sure you enable power to the module by pressing the Fn + key combination (the icon will be green).
11. See “Setting Up a Carrier Profile” on page 7 - 24 and “Connecting to the Service Provider” on page 7 - 26 for instructions on using the 3G Watcher application.
Fingerprint Reader Module

If you have included the fingerprint reader in your purchase option you will need to install the driver as per the instructions below.

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the fingerprint tutorial. To run the tutorial click Start > Programs/All Programs > Protector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install FingerPrint Driver > Yes.
4. Click Software Installation.
5. Click Next > Next > Next.
6. Click Finish > Yes to restart the computer.
7. See “User Enrollment” on page 7 - 31 for information on how to initialize the Fingerprint Reader.
Windows XP Information